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LANDWorksCAD V5 Manual

Introduction

Welcome

Welcome to LANDWorksCAD-V5 and the manual that will help you design your
landscapes “better, faster and funner™?”.

LANDWorksCAD is easy-to-use, professional-level software specifically created
for landscapers’ needs.

You can use LANDWorksCAD to create sketch plans, concept plans, planting
plans, hardworks plans, construction details, plant schedules, contour plans and
more...

With LANDWorksCAD Pro you can produce three dimensional models of your
landscape design, which can be viewed from any position and any angle.

LANDWorksCAD also includes an extensive plant database thatis linked to a
simple, editable Excel file allowing you to easily set up plants that are specific to
you and your area.

The Error! Reference source not found. section on page Error! Bookmark
not defined. shows just a few examples of the type of drawings and models that
can be created using LANDWorksCAD.

We've spent hundreds of hours producing this manual to show you how to use
the LANDWorksCAD menu, but we know you'll find ways to use the software we
had never thought of © so we are looking forward to receiving your thoughts and
comments about the software and this manual. If you wish to provide feedback
please call +61 2 9973 4499 or send an email to Error! Hyperlink reference
not valid..
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About this Manual

This manual only provides information on the commands in the LANDWorksCAD
menu, as indicated in the image below, and the associated Excel plant database.

For information relating to all the other commands, menus and screen areas, as
well as underlying concepts, such as system requirements, installation
procedure, software licensing, screen resolution, etc, you must refer to the
“RealCAD V5.xReference and User Manual”, where they are fully explained.

The manuals are structured in this waybecause LANDWorksCAD is an
“application” program for RealCAD. That is, LANDWorksCAD is a program
written to operate within RealCAD. While RealCAD can operate all by itself,
LANDWorksCAD relies on RealCAD to function.

RealCAD provides the underlying graphics engine that produces the required
images and line work for your drawings, but only in a general sense;
LANDWorksCAD controls them and points them in a landscaping direction.
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This manual has been produced for users of LANDWorksCAD LT (2D only) and
LANDWorksCAD Pro (2D and 3D). When using a 2D-only version, references to
the Z axis or Z coordinates will be disabled as they are not required.

The terms “Drawing” and “Model” are interchangeable in this manual.

Note: You can activate the 3D tools at any time by purchasing an upgrade to a
3D version. No additional software is required, just a new 3D license Key.

Even if you've been using the software for a while, take the time to read through
this manual as you'll find new ways of doing things and shortcuts you may not
have thought of.

Disclaimer: All care has been taken to ensure the accuracy of the information contained in
this document, however no warranty expressed or implied is given that this information is
either current or accurate and should not be relied on for any purpose.

Copyright© 2006 CAD International, Author Bill Murch All Rights Reserved.

No part of this publication may be reproduced or transmitted in any form or by any means,
electronic or mechanical, including photocopying, recording or by any information or
storage retrieval system, without express permission in writing from CAD International.

This manual was produced using RealCAD™, LANDWorksCAD™, Microsoft Word®,
Microsoft Excel®, Photolmpact® and Microsoft WindowsXP®.

RealCAD and LANDWorksCAD are trademarks of CAD Australia Pty Limited. All other
trademarks are the property of their respective owners.
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Overview

This section provides a quick overview of LANDWorksCAD; the commands in the
menu and the database of plants that is supplied.

The LANDWorksCAD Commands

>

Used to insert and label plants at a concept stage of the design.

~ Used to insert, label and list plants that already exist on site.

~ Used to insert, label and list plants that are proposed for the design.

J
—» Used to change how the plants look.

€59 0@ |

—» Used to extract quantities, lengths and areas.

erry
Lurd=

: | Used to lay a grid over the design.

Used to create and edit 3D digital terrain models (DTM).

2\ Used to generate contour lines.

Used to generate 3D or elevation plant on the DTM.

Only available in
LANDWorksCAD Pro

7 —» Used to insert the Sun, for generating shadows on a DTM. )

? | Tells you the current version details of LANDWorksCAD.
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The Plant Database

LANDWorksCAD is supplied with an extensive plant database allowing you to
quickly and easily select the plants you want for your design. You can also edit
the plants that are supplied in the database as well as add your own thus
allowing you to easily set up plants that are specific to you and your area.

The following points give you some introductory information about the database.
For detailed instructions on how to work with it, refer to the Appendices at the
end of this manual, which begin on page 128.

The database:
e is a Microsoft Excel spreadsheet
¢ has a simple format and contains no formulae
e s called LandworksPlantDatabase.xls (it must be called this)
e s stored in the LANDWorksCAD-V5 folder (it must reside there)

e can be edited within LANDWorksCAD itself, ie, you do not need to know
anything about Excel!

e can also be edited directly in Excel



LANDWorksCAD V5 Manual

Command Detaills

This section explains each command in the LANDWorksCAD menu in detail.

It should be noted that the LANDWorksCAD menu does not necessarily have to
appear on the left hand side of the window as shown in previous images. This is
the default position only. It can be moved anywhere on the screen and also
docked to the edges of the window, just like any standard Windows’ window.
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Insert Concept Plant

A

PURPOSE: To select and insert a figure that represents the “concept” of a plant
or plants rather than a specific plant, eg, the figure might be used to represent
general ground cover before any particular ground cover has been decided upon.

The appropriate type of plant can be searched for and plants that have already
been inserted can be replaced.

When the command is selected, the following dialog box is displayed.

Select Concept Plants

Selected |tams:

Index description Ccategar shape headin label
33 description 2 Tree oval Conifers
34 description 3 Tree aval Ewergreen
35 description 4 Shrub zpikey Deszert Shrubs Dirought tolerant
36 description 5 Border saft Floral Border Mice edging for paths
krs description & Tree triangular Denze Windbreak Good for privacy hedgad
] description 7 Tree bell Broad cover
3 description 8 Tall Shrub spikey High Level Tropical
| risert ey Flamt | efete Flart I Save [Matabiase Reload Databasze " Allow Editing
Search Fields:
- | T | ~Plan
Field _Name Operator Walue Concept Figuie: (% Image: €
plan figure name ———
elev. figure name o i
image file name /'/ \
elav. image file name f "-\
description ! |
categony |
shape y
heading b y
label b y
. o
Search Reset
i~ Elewation/30
Concept Figure: Image:
Insert Figure
Diameter  [3000.00 -] A
1
o 9 @
1 Point I 2 Points | Scale 2 Points I I
Replace | Cancel I

This command also lets you edit your LANDWorksCAD Excel plant database
from within LANDWorksCAD. This is explained at the end of this section. For
details on editing your plant database directly in Microsoft Excel, refer to
Appendix 2 — Editing the Plant Database in Excel on page 141.

8
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Selecting a Concept Plant

The “Selected Items” area at the top of the dialog box lists the plants defined in
the “Concept Plants” tab of your LANDWorksCAD Excel plant database. This
database is called LandworksPlantDatabase.xIs and is found in the
LANDWorksCAD folder on your computer. Refer to Appendix 1 — The
LANDWorksCAD Plant Database on page 129 for more details on the database.

Selected ltems:
Index description cateqor shape headin label
33 deszcription 2 Tree owal Conifers
34 dezcription 3 Tree oval Evergreen
35 description 4 Shrub spikey Desert Shrubs Drought tolerant
36 dezcription 5 Baorder zoft Floral Barder Mice edging for paths
37 dezcription & Tree trianguilar Dense windbreak Good for privacy hedged
a8 description 7 Tree bell Broad cover
39 dezcription 8 Tall Shrub zpikey High Level Tropical

Note: The buttons just below the selected items area, ie, “Insert New Plant”,
“Delete Plant”, etc, let you edit your plant database from within
LANDWorksCAD and are explained later in the section entitled Editing
Concept Plants from within LANDWorksCAD on page 20.

Scrolling down will show more plants; scrolling sideways will show more data for
the plants.

Click once anywhere in the row of data for the plant you want. Preview images
of the plant will be displayed in the four, bottom, right hand boxes. Not all of the
boxes will necessarily display previews; it depends on what has been defined in
your LANDWorksCAD Excel plant database.

The top two previews show the ways the plan view of the plant can be displayed
in the drawing. You can switch between these displays whenever you want to
after the plant has been inserted — refer to Plant Display Switching on page 81.

~PFlan
Conhcept Figure: (& Image:
= Ty

y -
y b
R
i 1
|
'\ =
- B
%\%"'?;.,__‘__. ,}__'i'ﬁ‘y

The “ConceptFigure”preview is of a LANDWorksCAD drawing file, ie, it must
have been drawn in LANDWorksCAD or created in another CAD program and
then imported and saved in LANDWorksCAD.
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The “Image” preview is of a JPG or BMP (bitmap) format file. This could be an
actual photograph of the plant or it could be an artistic representation that has
been created outside of LANDWorksCAD using image editing software, eg,
Photolmpact. The JPG format is preferred because file sizes are much smaller.

Having two ways of displaying the plan view of the plant gives you flexibility in
how you presentyour concept drawings and, as stated earlier, you can switch
between them whenever you want to.

It is up to you to decide how simple or detailed the plan concept figure is.

Likewise it is up to you to decide if the image display is an actual photograph or a
computer generated image.

Both plan displays do not have to be created for every plant, though obviously
you must use at least one or nothing will be displayed on the screen.

The plan display to be inserted can be selected by clicking in the white dotabove
the preview so that a smaller black dot appears within it.

The information explained above also pertains to the Elevation/3D previews; the
concept figure is a LANDWorksCAD drawing file and the Image is a JPG or BMP
file.

— Elervation 30
Concept Figure: Image:

Note: The Elevation/3D figures cannot be inserted using this command. They
can be generated automatically via the Insert 3D Plants command (page
114) or inserted manually (refer to “Figure and Group commands” in the
RealCAD-V5 Reference Manual for more information on manually inserting
figures).

10
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Inserting the Selected Concept Plant
Inserting the selected concept plant is a two step process:

1. Select the diameter of the plant,

2. Insert the plant using the appropriate insertion method

— Inzert Figure

Dliamneter IDefauIt - I

o o 9

1 Paint I 2 Foints | Scale 2 Pointz |

Select the Diameter of the Plant

The diameter of the plant can be selected from the “Diameter” box, as shown
below:

— Inzert Figure

Drefaul

2R00.0 —|
a00.0
| Scale 2 Paointz |

Diameter

o

1 Paint

If the required diameter is not listed it can simply be typed directly into the box.

The word “Default”means the plant will be inserted at the size it was originally
drawn.

11
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Insert the Plant Using the Appropriate Insertion Method

Once the diameter has been selected, the plant can be inserted into your
drawing in three different ways: “1 Point”, “2 Points” or “Scale 2 Points”. These
methods are explained below.

1 Paint |or @

Clicking either of these buttons attaches an image of the plan view of the plant to
your crosshair and the plant is inserted where you click your left mouse button.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won't actually appear until you click.

2 Paints | a |
or

Clicking either of these buttons attaches an image of the plan figure of the plant
to your crosshair, but two mouse clicks are required to insert it. The first mouse
click positions the plant figure; the second click defines the orientation of the
plant, ie, you can spin it around.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won't actually appear until you click.

Scale 2 Points | ﬁl
or

Clicking either of these buttons attaches an image of the plan figure of the plant
to your crosshair, but two mouse clicks are required to insert it. The first mouse
click positions the plant figure; the second click defines the orientation and size,
or scale, of the plant, ie, you can spin it around and you can also make it larger
or smaller than the original image.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won't actually appear until you click.

This technique ignores the Diameter box.

12
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Note: If a plant has not been selected before any of these buttons are clicked,
the following dialog box will be displayed, indicating that a plant must be
selected from the “Selected Iltems” list.

Select

Select an item from the list.

Tip: If you want to insert more copies of a plant that you have already inserted
you don’t have to use this command again, you can simply copy the
plants. They will still be recognised as plants from your database. You
can use any of the standard ways of copying techniques:

The Translate (Copy) Entities command

The Copy Along command

The Copy Array command

The Edit - Copy and Edit > Paste technique

The CTRL+C and CTRL+V technique

The “drag the entity while holding down the CTRL key” technique

Refer to the RealCAD-V5 Reference Manual for details on commands and
techniques.

13
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Searching for Concept Plants

You can search for the plant you want using the Search Fields part of the
command. You can search on any of the data in the “Concept Plants” sheet of
your LANDWorksCAD Excel plant database.

Search Fields:

Field Mame | [ perator | " alue |
plan figure name

elev. figure name

image file name

elev. image file name

dezcription

categony

shape

heading

label

Search Reset

The Field Name column lists every column from your database; the Operator
column controls the range of data you are searching for and the Value column
provides limits for the search.

The database can be search in two ways, although they are similar.

Method 1

Double-click on the desired Field Name. This activates the “Compare Field
Name Properties” dialog box as shown below. Here the “Category” field was
selected.

Field Marme
Operator j
Walue j

Cahicel |

Select the type of search “Operator” from the drop-down list, as shown below.
Here “Equal” is selected.

14
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Compare Field Hame Properties x|
Field Hame Icategnl_l,l
Operator j

e W
Greater Than

,: Less Than |_|

Mot Equal

Select the desired search “Value” from the drop-down list as shown below. Here
“Tree” is selected. The values in the drop-down list will vary depending on the
Field Name selected. The values are extracted from your database.

Field Hame Icategory
Operator IEquaI j
Walue | j
Border
[ Medium shrub
Small ghrub
T all zhrub

_

Click OK to finish the process. Your Search Fields area will look as shown
below.

Search Fields:

Field Hame |meahr IUaME |
plan figure name

eley. figure name

image file name

elev. image file name

deszcription

categary
thape
heading
label

Search Reszet

You may repeat the above steps with other Field Names to create multiple
search criteria, eg, you might be searching for all trees that have an oval shape.

When you're happy with the search criteria, click the “Search” button. The
Selected Items area will change and display only the items that match the search
criteria. For example, the image below shows only Trees.

15
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Selected ltems: r——
Index | description category I shape I heading I label
32 description 1 Tree Triangular Place Heading here Place your description here
33 dezcription 2 Tree Owal Conifers This plant will create a barrier a...
Kt dezcription 3 Tree Owal Ewvergreen
a7 description B Tree Triangular Dense Windbraak
38 dezcription 7 Tree Bell Broad cover
 S—

The desired plant can now be selected from the filtered list and inserted as
described above.

Method 2

Click once on the desired “Field Name”. The Field Name will be highlighted as
shown below. Here the “Category” field was selected.

Search Fields:

Field M ame | Operator | Walue
plan figure name
elev. figure name
image file name
elev. image file name
dezcription
categey
zhape
heading
label

Search Reset
| |

Click in the green highlighting line under the “Operator” heading. A drop down
field will appear as shown below.

Search Fields:

Figld M ame | Operator | Walle
plan figure name

eley. figure name

image file name

ele. image file name

dezcriptian

thape
heading
label

Search | Reset |

16
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Select the type of search “Operator” from the drop-down list, as shown below.
Here “Equal” is selected.

Search Fields:

Field Marme | Operator | W alue
plan figure name

eler. figure name

image file name

elew. iImage file name

dezcriptian
shape
heading
label Mat Equal
Lezs Than
Search | R| Greater Than

Now click the green highlighting line under the “Value” heading. A drop down
field will appear as shown below.

Search Fields:

Field Mame | Operator | Walue |;|
COMMON Name

Common name 2 |
Cutivars

fawourites

e ]
habit

texture
maximLm width
maximurn height ;I

Search | Fezet |

Select the desired search “Value” from the drop-down list as shown below. Here
“Palm” is selected. The values in the drop-down list will vary depending on the
Field Name selected. The values are extracted from your database.

Search Fields:

Field Mame | Operator | Walue |
plan figure name

eler. figure name

imaae file name

elew. iImage file name

dezcriptian
shape
lhia'f'"g Tall shub
ahe Medium shiub
Small shrub
Search | Feset | Border

17
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Your Search Fields area will look as shown below.

Search Fields:

Field Mame | Operator |Vabe |
plan figure name

elev. figure name

image file narme

elev. image file name

description

zhape
heading
label

Search | Reset |

You may repeat the above steps with other Field Names to create multiple
search criteria, eg, you might be searching for all trees that have an oval shape.

When you're happy with the search criteria, click the “Search” button. The
Selected Items area will now display only the items matching the search criteria,
eg, the image below shows only trees.

Selected ltems:
Index | description | category | shape | heading | label
32 dezcription 1 Tree Triangular Place Heading here Place wour description here
33 description 2 Tree Ovwal Conifers Thizg plant will create a barmier a...
34 description 3 Tree Ovwal Everagreen
Kr dezcription & Tree Triangular Denze Windbreak
38 description 7 Tree Bel Broad cover
——

The desired plant can now be selected from the filtered list and inserted as
described above.

Resetting the Search Criteria

To clear the filtered list of plants and display all the plants in the database again,
click the “Reset” button and then click the “Search” button.

18
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Replacing Already Inserted Concept Plants

The “Replace” button lets you replace plants that have already been inserted into
the drawing with other plants from the database.

This can be done in either of two ways:
1. You can select the plants to be replaced and then run the command, or

2. You can run the command first and then select the plants to be replaced

The two methods are nearly identical. The main difference is in how you can
select the plants to be replaced.

Select the plants to be replaced and then run the command

Step 1 — Select the plants that have already been inserted into the drawing.
You can use any selection technique for this.

Step 2
Step 3
Step 4 — Click the “Replace” button.

Run the “Insert proposed Plant” command (this command).

Select the replacement plant from the “Selected Items” list.

The selected plants will be replaced.

Run the command first and then select the plants to be replaced
Step 1 — Run the “Insert proposed Plant” command (this command).
Step 2 — Select the replacement plant from the “Selected Items” list.
Step 3
Step 4

Click the “Replace” button.

Select the plants that have already been inserted into the drawing.
You can only select plants one at a time using this method.

The selected plants will be replaced.

19
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Editing Concept Plants from within LANDWorksCAD

The buttons and tick box displayed just below the “Selected Items” area let you
edit your plant database from within LANDWorksCAD. This means you don’t
actually have to know anything about Microsoft Excel to be able to edit your
database. ©

However, your plant database can also be edited directly in Microsoft Excel.
Referto Appendix 2 — Editing the Plant Database in Excel on page 141 for
details.

Selected Items:

description

description 2 Carifers
34 description 3 Tree oval Ewergreen

i} description 4 Shrub spikey Degert Shrubs Drought tolerant
36 dezcription 5 Border soft Floral Border Mice edging for paths
37 dezcription & Tree triangular Dense windbraak, Good for privacy hedged
38 description 7 Tree bell Broad cover
9 deszcription 8 TallShrub  spikey High Lewvel Tropical
[ sert e Flant | [elete Blant | S ave Databage | Reload Database | [ Allows Editing

When the dialog box is displayed, the buttons giving you access to the plant
database - “Insert New Plant”, “Delete Plant” and “Save Database” —are
“greyed-out”, ie, they are not accessible. This is to avoid plant data being
accidentally edited. The “Reload Database” button is available in case the
database has been edited in Excel while LANDWorksCAD is open.

Important Note

You can edit the database in Excel while LANDWorksCAD is
running, but you cannot and must not edit the database from within
LANDWorksCAD while the database is open in Excel.

work in Windows — you cannot work on the same file, at the same
time, with two different programs. If the database is open in Excel
when you save it from LANDWorksCAD, you will get an error

I |
| |
I |
| |
l |
| This is not a limitation of LANDWorksCAD; it is a simply how files |
I |
| |
I |
| message and LANDWorksCAD will lock up or crash. |

To activate the greyed-out buttons and allow editing of your plant database, click
the “Allow Editing” box, so that a tick is visible. The buttons will then look like
this:

Irizert Mew Flant | Delete Flant | Save Databaze | Reload D atabase | v Allaw Editing

You can also edit plants that are already in the database, although there is no
specific button for this.

20
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The editing functionality is explained below:

Edit a Concept Plant already in the Database (no button)

To edit the data of aconcept plant already in the database simply click on the
text and edit it. The row of data will be highlighted in green, except for the
specific text to be edited, which will remain white for ease of typing.

You can also press the Tab key to move to the next column.

Some columns provide a list of data to choose from, indicated by a downward
pointing triangle. Clicking on the triangle displays the list, as shown below:

Selected lkems:

description 2 Tree

34 description 3 Tree
35 description 4 Shrub
3B description 5 Border
ar deszcription & Tree
] Aazrrinbinn 7 Traa

When such a list is available you cannot type in something that is not already in
the list; you can only select data from the list. You can, however, edit and add to
the list by editing the database in Excel. See Appendix 2 — Editing the Plant
Database in Excel on page 141 for details on doing this.

To change the figure or image file for the plant, simply click in the relevant
preview box and the following dialog box will be displayed allowing you to browse
for the appropriate file.

Open
Look, in; I ) Plantz j = Ei‘ '

g EFlower Border 1.CAD
|| %Flower Border 1-E.CAD
|| %Flower Border 3.CAD
g %Flower Border 3B cad
&/ %Flower Border 4.cad
&| Flower Border 4-E.CAD

enenc-1.CaD
enernc-1-E.CAD
eneric-2.CaD
enenic-2-E. Cal
eneric-3.CA0
enenic-3-E.Cal

[ i

File narme: | Open I
Files of type: Il:ad Files *.cad j Cancel |

[ Open as read-only

3y
e, (e[ i@ [@ [
iy

1=

21
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you have found the file, select it and click the Open button. The file will
e displayed in the preview box.

you select a plant figure or image using this technique, LANDWorksCAD is

editing data to columns you can't see, “behind the scenes”. This data is the path
and filename of the selected figure/image file. If you cancel the dialog box, the

followi

Click t
entere

ng message will appear:

Clear Filename E2

Do you want to clear the filename for this item?

ez Mo |

he Yes button if you want to completely clear the filename data that was
d, if any. Click the No button if you want to retain the filename data that

was there, if any.

Notes:
1.

When browsing for figures, the “Files of type” section of the dialog box is
limited to “Cad Files *.cad” so you will only see LANDWorksCAD type
files. Elevation/3D figures have a “-E” at the end of their name for ease of
identification.

When browsing for image files, the “Files of type” section of the dialog
box is limited to “Image Files *.bmp, *.jpg” so you will only see those
types of files. Elevation/3D image files have a “E” at the end of their
name for ease of identification.

Selecting the appropriate plant figure/image file is a simple process, but
there is one important prerequisite — the figure or image file must exist
before it can be selected, ie, it must have been drawn/created first.

I Important Note |
I When you have finished editing your plants, it is vitally important |
I that you save the changes to the database by clicking the “Save |

Database” button (see below). If you don't, you will lose the |
| changes. |

22
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Insert New Plant
There are two stages to inserting a new plant:
1. Entering the data, and

2. Selecting the appropriate figures and image files

Entering the data

When the “Insert New Plant” button is clicked, a blank row is inserted above the
plant that is currently selected in the “Selected Items” list. The relevant data for
the new plant can then be typed in.

Selected Ibems:
Index | description | category | shape I heading I label -
32 dezcription 1 Tree triangular Flace Heading here Place your description here
33 description 2 Tree oval Conifers
34 description 3 Tree oval Everareen
35 dezcription 4 Shrub zpikey Degert Shiubs Drrought tolerant
36 dezcription 5 Border zoft Floral Border Mice edging for paths
ar
a8 deszcription § Tree triangular Denze windbreak Good for privacy hedged b
39 deszcription 7 Tree bell Broad cover LI
Insert Mew Plant I Delete Plant | Save Databaze | Reload D atabasze | IV Allow Editing

To enter the data, click on the blank row, in the column you want to edit and type
in the required data. When you select the blank row it will be highlighted in
green, but the part of the row in the column you selected will remain white.

You can also press the Tab key to move to the next column.

Some columns provide a list of data to choose from, indicated by a downward
pointing triangle. Clicking on the triangle displays the list, as shown below:

Selected [tems:

dezcription

description 2 Caor

34 dezcrption 3 Tree Ewe
Kis description 4 Shrub De:
36 dezcription 5 Brarder Flon
7 description B Tree Triangular Bl B
n Aacrrinban 7 Traa P Bra

When such a list is available you cannot type in something that is not already in
the list; you can only select data from the list. You can, however, edit and add to
the list by editing the database in Excel. Appendix 2 — Editing the Plant
Database in Excel on page 141 for details on doing this.

Multiple new plants can be inserted by simply clicking the button again and
entering the data.

23
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It's up to you to decide how much data you enter. Most columns are not
compulsory. Refer to Appendix 1 — The LANDWorksCAD Plant Database on
page 129 for details on the database.

Selecting the appropriate figures and image files
Once the botanical data has been entered, appropriate LANDWorksCAD figures
and image files must be selected to represent the plant in the drawing.

To select the plant figure or image file, simply click in the relevant preview box
and browse and select the appropriate file, as described in the Edit a Concept
Plant already in the Database (no button) section above.

Note that both of the preview boxes do not have to be filled in, but at least one
must be, otherwise there will be nothing to see when the plant is inserted. ©

The Elevation/3D figures and images are not required at all if you are only
working in 2D.

l ___________________________ |
| Important Note |

| When you have finished inserting your plants, it is vitally important |
| that you save them to the database by clicking the ‘Save |
| Database” button (see below). If you don’t, you will lose them. J|

Delete Plant

To delete a plant, select the plant by clicking anywhere in its row and then click
the “Delete Plant” button. The following confirmation dialog box will appear (with
the appropriate plant name, of course):

Delete Plant 2

Delete plant Landzcape-SymbolehPlante%Flower Border 4.cad?

es Mo |

Click the Yes button to confirm you want to delete the plant from the database.
Click the No button if you do not want to delete the plant.
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| When you have finished deleting plants, it is vitally important that |
Iyou save the changes to the database by clicking the “Save |
| Database” button (see below). If you don't, the plants will not be |

permanently deleted. I

l- - - -

Save Database

After you have done any editing, inserting or deleting of plants, you should click
the “Save Database” button so the changes are stored permanently in the
database. If you don’t, the changes will not be remembered by
LANDWorksCAD, ie, plants you thought you added to the database will not be
there, plants you thought you deleted will still be there, etc.

Reminder Note

Youcan edit the database in Excel while LANDWorksCAD is
running, but you cannot and must not edit the database from within
LANDWorksCAD while the database is open in Excel.

work in Windows — you cannot work on the same file, at the same
time, with two different programs. If the database is open in Excel
when you save it from LANDWorksCAD, you will get an error
message and LANDWorksCAD will lock up or crash.

|
|
|
|
|
| This is not a limitation of LANDWorksCAD:; it is a simply how files
|
|
|
|

Reload Database

Clicking the “Reload Database” button forces LANDWorksCAD to re-read the
plant database and show any changes that have occurred since
LANDWorksCAD started.

This would be necessary if the database was edited in Excel while
LANDWorksCAD was running.

It would also be necessary if you have been editing the plant database from
within LANDWorksCAD and have made a few mistakes (it does happen! ©) and
want to start again.

25



LANDWorksCAD V5 Manual

Label Concept Plant

PURPOSE: To label concept plants inserted from the LANDWorksCAD Excel
plant database (usingthe Insert Concept Plant command — refer to previous
section) for identification on the landscape drawing.

When the command is selected, the following dialog box is displayed.

Label Concept Plant B4 |

Text size 4.00 i

Scale text by the plot scale W

Canicel |

Text Size

This box lets you define the size of the label text. Text size is influenced by the
nextoption, Scale Text by the Plot Scale and can work in either of the following
two ways

1.

If the Scale Text by the Plot Scale option is ticked, then the text size
entered is automatically multiplied by the view’s Plot Scale and the text is
displayed on the screen at that scaled size.

For example, if a text size of 4mm is entered and the Plot Scale is 100, the
text will be displayed on screen at 400mm high.

This technique lets you define the text size based on the height you want it
to be when it is printed on paper. If the Plot Scale is changed for some
reason, the on-screen text height will automatically adjust, but, providing
you print the drawing at the specified Plot Scale, the text will always print
at the height specified.

For example, a text height of 4mm and a Plot Scale of 100 produces on-
screen text at 400mm high. Printing the drawing at a scale of 1:100 will
produce text 4mm high on the paper. Change the Plot Scale to 200 and
the on-screen text will become 800mm high, but printing the drawing at a
scale of 1:200 will still produce text 4mm high on the paper.

Ifthe Scale Text by the Plot Scale option is not ticked, then the text size
entered is the on-screen height. It is not, in any way, affected by the
view's Plot Scale.
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For the text to be visible on the screen, the size must be calculated
accordingly.

This technique will produce printed text of a different size if the Plot Scale
is changed.

For example, if a text height of 400mm is specified and the Plot Scale is
100, the printed text will be 4mm high, but if the Plot Scale is changed to
200, the printed text would be 2mm high.

Scale Text by the Plot Scale

This tick box controls whether the text size entered is automatically multiplied by
the view's Plot Scale for on-screen display. Refer to the previous section, Text
Size for more details.

Inserting the Label

When the OK button is clicked, LANDWorksCAD scans the drawing for any
concept plants that haven't been labelled. If it finds some, it highlights in grey the
last plant inserted and its label is attached to your crosshair letting you position it
where it suits you.

The label for the plant is comprised of the text in the “Heading” and “Label”
columns of the plant database. These columns are displayed in the “Selected
Items” area of the “Insert Concept Plant” dialog box.

When you have placed the label for that concept plant, if there are any others
that have not been labelled, the next one is highlighted, its label attached to your
crosshair and so on.

Note: You do not have to select the plants at any stage

Note: The selection of plants is done in reverse order, ie, the last plant inserted
is highlighted first, then the second last plant inserted, etc.

Note: If you have the same concept plants inserted at various positions on the
drawing, you will only be able to label one group of them using this
command. To label the other groups of plants, simply copy the labels.

The following steps show how the command works.

In the image below the blue concept plants were inserted first, then the red ones
and then the green ones, so they will be labelled in the reverse order to that. (the
colours are not important; they are only used here for identification purposes)
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The command is selected and the text properties set. When the OK button is
clicked, the last green plant is highlighted in grey and its label attached to the
crosshair, as shown below.

Highlighted

Flaral Border

_|Mice edging for paths
Label attached
to crosshair

When the first label is inserted, the next concept plant is highlighted (red) and its
label is attached to the crosshair, as shown below.
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®  IEIIEE

@ Dense VWindhreak l_oalztrecl)sastthaacired
_|_G|:u:|d for privacy hedged
ot R First Label
Floral Border inserted

Mice edging for paths

Highlighted
in grey

When the second label is inserted, the next concept plant is highlighted (blue)
and its label is attached to the crosshair, as shown below. This would, of course,
continue if there were more plants that had not be labelled.

Highlighted
Label attached Desert Shrubs
to crosshair +Dru:nu ght tolerant

{% Dense VWindhreak
Good far privacy hedged

®

AN S e

Floral Eorder
Mice edging for paths

When the last label has been inserted, the command stops.

29



LANDWorksCAD V5 Manual

Insert Existing Plant

©
PURPOSE: To select and insert a figure to represent the plant(s) in your

landscape plan that already exist on-site.
When the command is selected, the following dialog box is displayed.

Select Existing Planis

Selected Items:

Index | plan figure name image file name dezcription categor
33 Landzcape-SymbalshPlantshXexisting ee .. Landszcape-Symbols'Plantsh¥concept-1.JPG Retain
34
[t vy FlarE | [elete Plant | Saye Database Fieload Database I” Hllow Editing
: —Plan
- Insett Figurs Figurs: & Imags:

Diameter IDefauIt YI

o 9 9
1 Paint I 2 Paints | Scale 2 Points |

Replace | Cancel |

This command also lets you edit your LANDWorksCAD Excel plant database
from within LANDWorksCAD. This is explained at the end of this section. For
details on editing your plant database directly in Microsoft Excel, refer to
Appendix 2 — Editing the Plant Database in Excel on page 141.

30



LANDWorksCAD V5 Manual

Selecting an Existing Plant

The “Selected Items” area at the top of the dialog box lists the plants defined in
the “Existing Plants” tab of your LANDWorksCAD Excel plant database. This
database is called LandworksPlantDatabase.xIs and is found in the
LANDWorksCAD folder on your computer. Refer to Appendix 1 — The
LANDWorksCAD Plant Database on page 129 for more details on the database.

Selected ltems:

Index | plan figure name image file name description categor

X Landscape-SymbolsiPlants\Zesizting tree ... Landscape-Symbols\Plantsh %concept-1.JPG Retain
34

Note: The buttons just below the selected items area, ie, “Insert New Plant”,
“Delete Plant”, etc, let you edit your plant database from within
LANDWorksCAD and are explained later in the section entitled Editing
Existing Plants from within LANDWorksCAD on page 36.

Scrolling down will show more plants; scrolling sideways will show more data for
the plants (if necessary).

Click once anywhere in the row of data for the plant you want. Preview images
of the plant will be displayed in the two, bottom, right hand boxes. Both of the
boxes will not necessarily display previews; it depends on what has been defined
in your LANDWorksCAD Excel plant database.

The two previews show the ways the plan view of the plant can be displayed in
the drawing. You can switch between these displays whenever you want to after
the plant has been inserted — refer to the Plant Display Switchingcommand on
page 81.

—Flan
Figure: & Image:
.y
. B
Yy N
y A
i
i
:'s.|
b
_}3‘
i
..a'_,‘-“&c

The “Figure” preview is of a LANDWorksCAD drawing file, ie, it must have been
drawn in LANDWorksCAD or created in another CAD program and then imported
and saved in LANDWorksCAD.
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The “Image” preview is of a JPG or BMP (bitmap) format file. This could be an
actual photograph of the plant or it could be an artistic representation that has
been created outside of LANDWorksCAD using image editing software, eg,
Photolmpact. The JPG format is preferred because file sizes are much smaller.

Having two ways of displaying the plan view of the plant gives you flexibility in
how you present your concept drawings and, as stated earlier, you can switch
between them whenever you want to.

It is up to you to decide how simple or detailed the plan concept figure is.

Likewise it is up to you to decide if the image display is an actual photograph or a
computer generated image.

Both plan displays do not have to be created for every plant, though obviously
you must use at least one or nothing will be displayed on the screen.

The plan display to be inserted can be selected by clicking in the white dot above
the preview so that a smaller black dot appears within it.

Inserting the Selected Existing Plant
Inserting the selected existing plant is a two step process:

1. Select the diameter of the plant,

2. Insert the plant using the appropriate insertion method

— Ingert Figure

Diarneter IDefauIt vI

o 9 9

1 Paint I 2 Points | Scale 2 Paints |

Select the Diameter of the Plant

The diameter of the plant can be selected from the “Diameter” box, as shown
below:
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— Inzert Figure

Defaul

25000 —|
500.0
| Scale 2 Points |

Diameter

If the required diameter is not listed it can simply be typed directly into the box.

The word “Default” means the plant will be inserted at the size it was originally
drawn.

Insert the Plant Using the Appropriate Insertion Method

Once the diameter has been selected, the plant can be inserted into your
drawing in three different ways: “1 Point”, “2 Points” or “Scale 2 Points”. These
methods are explained below.

Note: If you intend to label the existing plants using the Label Existing Plant
command (page 42), it is not really important which of the following
insertion techniques are used because the figure will be automatically re-
sized to match the data entered.

1Foint | o &

Clicking either of these buttons attaches an image of the plan view of the plant to
your crosshair and the plant is inserted where you click your left mouse button.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won't actually appear until you click.

2 Pointz | or a |

Clicking either of these buttons attaches an image of the plan figure of the plant
to your crosshair, but two mouse clicks are required to insert it. The first mouse
click positions the plant figure; the second click defines the orientation of the
plant, ie, you can spin it around.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won't actually appear until you click.
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Scale 2 Paoints | ‘l
or

Clicking either of these buttons attaches an image of the plan figure of the plant
to your crosshair, but two mouse clicks are required to insert it. The first mouse
click positions the plant figure; the second click defines the orientation and size,
or scale, of the plant, ie, you can spin it around and you can also make it larger
or smaller than the original image.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won't actually appear until you click.

This technique ignores the Diameter box.

Note: If a plant has not been selected before any of these buttons are clicked,
the following dialog box will be displayed, indicating that a plant must be
selected from the “Selected Items” list.

Select

Select an item from the list.

Tip: If you want to insert more copies of a plant that you have already inserted
you don't have to use this command again, you can simply copy the
plants. They will still be recognised as plants from your database. You
can use any of the standard ways of copying techniques:

e The Translate (Copy) Entities command

e The Copy Along command

e The Copy Array command

e The Edit » Copy and Edit > Paste technique

e The CTRL+C and CTRL+V technique

e The “drag the entity while holding down the CTRL key” technique

Refer to the “RealCAD V5.x Reference and User Manual” for details on
commands and techniques.
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Replacing Already Inserted Existing Plants

The “Replace” button lets you replace plants that have already been inserted into
the drawing with other plants from the database.

This can be done in either of two ways:
1. You can select the plants to be replaced and then run the command, or
2. You can run the command first and then select the plants to be replaced

The two methods are nearly identical. The main difference is in how you can
select the plants to be replaced.

Select the plants to be replaced and then run the command

Step 1 — Select the plants that have already been inserted into the drawing.
You can use any selection technique for this.

Step 2
Step 3 — Select the replacement plant from the “Selected Items” list.

Run the “Insert proposed Plant” command (this command).

Step 4 — Click the “Replace” button.

The selected plants will be replaced.

Run the command first and then select the plants to be replaced

Step 1 — Run the “Insert proposed Plant” command (this command).

Step 2 — Select the replacement plant from the “Selected Items” list.
Step 3 — Click the “Replace” button.
Step 4 — Select the plants that have already been inserted into the drawing.

You can only select plants one at a time using this method.

The selected plants will be replaced.
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Editing Existing Plants from within LANDWorksCAD

The buttons and tick box displayed just below the “Selected Items” area let you
edit your plant database from within LANDWorksCAD. This means you don’t
actually have to know anything about Microsoft Excel to be able to edit your
database. ©

However, your plant database can also be edited directly in Microsoft Excel.
Referto Appendix 2 — Editing the Plant Database in Excel on page 141 for
details.

Selected Items:

image file name description

Landzcape-SymbolghPlantshZconcept-1.JPG - Retain

Landzcape-SymbolshPlantshZexisting ee .

[ Fsert e Bt | [Defete Blant | Save Database | Relnad Database | " Allows Editing

When the dialog box is displayed, the buttons giving you access to the plant
database - “Insert New Plant”, “Delete Plant” and “Save Database” —are
“greyed-out”, ie, they are not accessible. This is to avoid plant data being
accidentally edited. The “Reload Database” button is available in case the
database has been edited in Excel while LANDWorksCAD is open.

Important Note

You can edit the database in Excel while LANDWorksCAD is
running, but you cannot and must not edit the database from within
LANDWorksCAD while the database is open in Excel.

work in Windows — you cannot work on the same file, at the same
time, with two different programs. If the database is open in Excel
when you save it from LANDWorksCAD, you will get an error
message and LANDWorksCAD will lock up or crash.

|
|
|
|
This is not a limitation of LANDWorksCAD; it is a simply how files |
|
|
|
|

To activate the greyed-out buttons and allow editing of your plant database, click
the “Allow Editing” box, so that a tick is visible. The buttons will then look like
this:

Irizert Mew Flant | Delete Flant | Save Databaze | Reload D atabase | v Allaw Editing

You can also edit plants that are already in the database, although there is no
specific button for this.
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The editing functionality is explained below:

Edit an Existing Plant already in the Database (no button)

To edit the data of an existing plant already in the database simply click on the
text and edit it. The row of data will be highlighted in green, except for the
specific text to be edited, which will remain white for ease of typing.

You can also press the Tab key to move to the next column.

To change the figure or image file for the plant, simply click in the relevant
preview box and the following dialog box will be displayed allowing you to browse
for the appropriate file.

Open

Lok, ir: I =2} Plants j (= cF Ef-

(=] %Flower Border 1.CAD | =] %Generic-1.CAD

|=] Flower Border 1-E.CAD |=] #Generic1-E.CAD

|=] %Flower Border 3.CAD |=] %Generic-2.CAD

g ZFlower Border 3-E.cad @ ZGenernc-2-E.CAD

ﬂ %Flower Border 4.cad @ %Generic-3.CaD

|| %Flower Border 4-E.CAD |=] %Generic-3-E.CAD

4] [ i

File narme: | Open I
Files of type: Il:ad Files *.cad j Cancel |

[ Open as read-only

i

When you have found the file, select it and click the Open button. The file will
then be displayed in the preview box.

When you select a plant figure or image using this technique, LANDWorksCAD is
editing data to columns you can't see, “behind the scenes”. This data is the path
and filename of the selected figure/image file. If you cancel the dialog box, the
following message will appear:

Clear Filename

Do pou want to clear the filename for this ikem?

ez Mo |
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Click the Yes button if you want to completely clear the filename data that was
entered, if any. Click the No button if you want to retain the filename data that
was there, if any.

Notes:

1. When browsing for figures, the “Files of type” section of the dialog box is
limited to “Cad Files *.cad” so you will only see LANDWorksCAD type
files.

2. When browsing forimage files, the “Files of type” section of the dialog
box is limited to “Image Files *.bmp, *.jpg” so you will only see those
types of files.

3. Selecting the appropriate plant figure/image file is a simple process, but
there is one important prerequisite — the figure or image file must exist
before it can be selected, ie, it must have been drawn/created first.

I Important Note |
I When you have finished editing your plants, it is vitally important |
I that you save the changes to the database by clicking the “Save |

Database” button (see below). If you don’t, you will lose the |
I changes. I

Insert New Plant
There are two stages to inserting a new plant:
1. Entering the data, and
2. Selecting the appropriate figures and image files

Entering the data

When the “Insert New Plant” button is clicked, a blank row is inserted above the
plant that is currently selected in the “Selected Items” list. The relevant data for
the new plant can then be typed in.
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Selected Ibems:

Index | plan figure name | image file name I dezcription I categony I
32 Landscape-Symbolz\Plants\ Xexizting tree .. Landscape-Symbols\Plants\%concept-1.JPG Remaove

33 MNeww Plant

34 Landscape-Symbols\Plants\Zexisting tree ... Landscape-Symbols\Plants\*%concept-1.JPG - Retain

35

Insert Mew Plant I Delete Plant | Save Database | Reload D atabase | I Allow: Editing

To enter the data, click on the blank row, in the column you want to edit and type
in the required data. When you select the blank row it will be highlighted in
green, but the part of the row in the column you selected will remain white.

You can also press the Tab key to move to the next column.

Multiple new plants can be inserted by simply clicking the button again and
entering the data.

It's up to you to decide how much data you enter. Most columns are not
compulsory. Refer to Appendix 1 — The LANDWorksCAD Plant Database on
page 129 for details on the database.

Selecting the appropriate figures and image files
Once the botanical data has been entered, appropriate LANDWorksCAD figures
and image files must be selected to represent the plant in the drawing.

To select the plant figure or image file, simply click in the relevant preview box
and browse and select the appropriate file, as described in the Edit an Existing
Plant already in the Database (no button) section above.

Note that both of the preview boxes do not have to be filled in, but at least one
must be, otherwise there will be nothing to see when the plant is inserted. ©

: Important Note |
| When you have finished inserting your plants, it is vitally important |
| that you save them to the database by clicking the ‘Save |
| Database” button (see below). If you don't, you will lose them.

Delete Plant

To delete a plant, select the plant by clicking anywhere in its row and then click
the “Delete Plant” button. The following confirmation dialog box will appear (with
the appropriate plant name, of course)
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Delete Plant

Delete plant Landzcape-SymbolsiPlantsh%Flower Border 4.cad?

Yes Mo |

Clickthe Yes button to confirm you want to delete the plant from the database.
Click the No button if you do not want to delete the plant.

When you have finished deleting plants, it is vitally important that |
you save the changes to the database by clicking the “Save |
Database” button (see below). If you don't, the plants will not be |

:_permanently deleted. |

Save Database

After you have done any editing, inserting or deleting of plants, you should click
the “Save Database” button so the changes are stored permanently in the
database. If you don't, the changes will not be remembered by
LANDWorksCAD, ie, plants you thought you added to the database will not be
there, plants you thought you deleted will still be there, etc.

Reminder Note

You can edit the database in Excel while LANDWorksCAD is
running, but you cannot and must not edit the database from within
LANDWorksCAD while the database is open in Excel.

work in Windows — you cannot work on the same file, at the same |
time, with two different programs. If the database is open in Excel |
when you save it from LANDWorksCAD, you will get an error |

|
|
|
|
|
| This is not a limitation of LANDWorksCAD; it is a simply how files |
|
|
|
I message and LANDWorksCAD will lock up or crash. |
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Reload Database

Clicking the “Reload Database” button forces LANDWorksCAD to re-read the
plant database and show any changes that have occurred since
LANDWorksCAD started.

This would be necessary if the database was edited in Excel while
LANDWorksCAD was running.

It would also be necessary if you have been editing the plant database from
within LANDWorksCAD and have made a few mistakes (it does happen! ©) and
want to start again.
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Label Existing Plant
T

PURPOSE: To label existing plants inserted from the LANDWorksCAD Excel
plantdatabase (using the Insert Existing Plantcommand — refer to previous
section) for identification on the landscape drawing and forinclusion in a
schedule of existing plants.

The data entered in this command is the data typically collected when the client’s
property is surveyed.

When the command is selected, the following dialog box is displayed.

Lobel Bristing Plant K|

Botanical Name |Acacia busifalia =]
Label itern using |ﬂEEHEVIﬁ.TIDN =]
Iterm Mame I.-'l'-.n:: b

Label Prefis T
Text Size IEEII:I— i
Trunk. Diarmeter I'“:”J—
Height [000
Spread IS‘EIEIEI—

Status 1 Ilnfected j
Statusz 2 IFiemu:we j
Comments IF'ermissiu:un required

Scale text by the plot scale W

Cancel |

The “Label Prefix” is used to actually label the plant; the other data will be
displayed in the “Existing Plant Schedule” when it is inserted. (refer to the
Existing Plant Schedule command on page 49)

Note: For an existing plant figure to be included in the Existing Plant Schedule it
MUST be labelled with this command first.

42



LANDWorksCAD V5 Manual

An example of a label is shown below — the “T1" text.

Botanical Name

This box lets you choose the botanical name of the existing plant you are about

to label.

Clicking on the triangle at the end of the box displays a list of the botanical

names from your plant database, as shown below:

lobel Existing Plart [

Eotanical MWame
Label item uszing
[tern M ame
Label Prefix
Text Size

Trunk Diarneter
Height

Spread

Status 1

Status 2

Commernts

M cacia buxifolia
Azacia buxifolia
Acacia decurens
Acacia zowdenii
Acacia zpetabiliz
Acer abrum
Actinotus helianthi
Adianturm hizpidulum
Aezculus pavia
Agapanthuz proecox

|4IIII:IIII
IEDEIEI

IInfected j
IFlemm-'e j

IF'ermissiDn required

Scale kext by the plot scale [

Cancel |
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Label Item Using
This box lets you choose which data from the database will be used to identify
the existing plant in the Existing Plant Schedule.

Clicking on the triangle at the end of the box displays a list of the field names
from your plant database, as shown below:

T N

Botanical Mame I.-'-\l:ac:ia buifolia j
Label item wizing abhbreviation j
Ik M arme 3D figure name
Label Prefix abbreviation-2
adverse factors
Text Size attracts
auturnn/fall leaf colour
Trunk. Diameter bark colour
: bark zhedding
Height bark, texture -
r

Spread ISEIEIEI
Statuz 1 IInfected j
o

Status 2 IHemwe

Camments IF'ermissicun required

Scale text by the plat scale W

Cancel |

In the example below, the tree being labelled is an Acacia buxifolia, but it will be
identified in the Existing Plant Schedule with its abbreviation, ie, Ac bu.

Batanical Mame I.-'-\l:ac:ia bifolia j
Label itern using |ﬁBBHEVIATIDN =]
Item Mame I.-'-‘-.c b

Item Name

This box displays the actualidentifying text that will be displayed in the Existing
Plant Schedule, eg, “Ac bu” in the example above.
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Label Prefix

This box lets you enter text that will be displayed as a label for the plant on the
drawing. Any amount of text can be entered.

Numbers are automatically appended to the prefix, ensuring the labels are
unique.

Typically the prefix would be a code to identify the type of plant, eg, “T” for tree,
“S” for shrub, etc, but it can be anything.

Examples are shown below.

Sh4
Sh5

Sh6

Text Size

This box lets you define the size of the label text. Text size is influenced by the
bottom tick box, Scale Text by the Plot Scale and can work in either of the
following two ways

1. Ifthe Scale Text by the Plot Scale option is ticked, then the text size
entered is automatically multiplied by the view’s Plot Scale and the text is
displayed on the screen at that scaled size.

For example, if a text size of 4mm is entered and the Plot Scale is 100, the
text will be displayed on screen at 400mm high.

This technique lets you define the text size based on the height you want it
to be when it is printed on paper. If the Plot Scale is changed for some
reason, the on-screen text height will automatically adjust, but, providing
you print the drawing at the specified Plot Scale, the text will always print
at the height specified.

For example, a text height of 4mm and a Plot Scale of 100 produces on-
screen text at 400mm high. Printing the drawing at a scale of 1:100 will
produce text 4mm high on the paper. Change the Plot Scale to 200 and
the on-screen text will become 800mm high, but printing the drawing at a
scale of 1:200 will still produce text 4mm high on the paper.
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2. Ifthe Scale Text by the Plot Scale option is not ticked, then the text size
entered is the on-screen height. It is not, in any way, affected by the
view's Plot Scale.

For the text to be visible on the screen, the size must be calculated
accordingly.

This technique will produce printed text of a different size if the Plot Scale
is changed.

For example, if a text height of 400mm is specified and the Plot Scale is
100, the printed text will be 4mm high, but if the Plot Scale is changed to
200, the printed text would be 2mm high.

Trunk Diameter

This box lets you enter the actual diameter of the trunk of the plant, in mm, as
measured on site.

Height

This box lets you enter the actual height of the plant, in mm, as measured on
site.

Spread

This box lets you enter the actual spread, or foliage diameter, of the plant, in mm,
as measured on site. The value of the ‘Spread’ is used to automatically re-size
the selected figure to the correct diameter.

Status 1

This box lets you select from four, standard, predefined status notes to be
included in the Existing Plant Schedule.

Clicking on the triangle at the end of the box displays the four notes, as shown
below. Simply delete the note if you do not want it included in the schedule.
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Label Existing Plant E3
Eotanical Name Iﬂgapanlhus progcos j
Label item using [AEBREVIATION =]
Item Mame IAEI pr

Label Prefis [sh
Text Size |5IJIJ— i
Trunk Diameter IW
Height [oo0m0
Spread IW

Status 1

Status 2

Comments Remove

Scale text by the plat scale W

Cancel |

Status 2

This box lets you select from four, standard, predefined status notes to be
included in the Existing Plant Schedule.

Clicking on the triangle at the end of the box displays the four notes, as shown
below. Simply delete the note if you do not want it included in the schedule.

Label Existing Plant x|
Botanical Mame I.ﬁ.gapanthus proecos j
Label itsr using [4EBREVIATION =]
Itermn M arme I-"—"-EI pr

Label Prefix EX
Text Size |5IJIJ— i
Trunk Diameter IW
Height [200000
Spread IW

Status 1 IHetain j
Status 2
Comments Almozt Dead

|nfected

Cancel |
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Comments

This box lets you type in additional information to be included in the Existing
Plant Schedule. The amount of text is not limited by the width of the box.

Scale Text by the Plot Scale

This tick box controls whether the text size entered is automatically multiplied by
the view’'s Plot Scale for on-screen display. Refer to the earlier section, Text
Size, for more details.

Inserting the Label
When the OK button is clicked, the steps to label the plant are as follows:

1. Select the plant to label.

When the plant is selected, it turns grey and the prefix label and number
are attached to your crosshair, as shown below.

s
K
i
T
| L
L
by
-
R

Iy

Selected plant
turns grey

Label attached
to crosshair

2. Position the label and click to insert it.

3. The label is inserted and the figure is re-sized to match the “spread” value

entered, as shown below.

4. The command is automatically re-run, letting you label more plants.

Plant has been re-
sized to match the
“spread” value
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Existing Plant Schedule

PURPOSE: To automatically generate a schedule of existing plants based on the
criteria entered using the Label Existing Plant command.

Note: For an existing plant figure to be included in the Existing Plant Schedule it
MUST be labelled with Label Existing Plant command first.

A sample Legend is shown below.

Existing Vegetation

Mo Species Trunk Diam Height Spread Status

31 Ac bu 100mm 3000mm 3000mm Retain

52 Baer 7amm 4000mm 3000mm Retain

T3 Euma 300mm 10000mm | 8000mm Retain

T4 Sc ac 200mm 7000mm 3000mm Remove

Th An co 300mm 12000mm 7000mm | Almost Dead Remove Permission required

When the command is selected, the following dialog box is displayed.

Insert Plant Schedule ]|

Heading IE:-:isting Wegetation

T able Size |1 200.00 T

¥ Show Diameter
V¥ Show Height
¥ Show Spread
¥ Show Status
¥ Show Borders

Cancel |

Heading

Text typed in this box will be displayed at the top of the Schedule as a heading.
If you do not want a heading leave this box blank
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Table Size

This box controls the height, in mm, of each row in the Schedule. It should be
adjusted to suit the scale of the drawing you are creating.

A simple “rule of thumb” to determine a suitable size for the table is as follows:
1. Decide how high you want the Legend text to be when printed, eg, 4mm
2. Add 2mm, to allow a 1mm space above and below the text, > 6mm
3. Multiply that number by the Plot Scale, eg, a Plot Scale of 200 gives 1200
4

Use this final number as the “Table Size”

Show Diameter

If this box is ticked the trunk diameter of the plants, as entered in the Label
Existing Plant command, will be included in the Schedule.

Show Height

If this box is ticked the height of the plants, as entered in the Label Existing Plant
command, will be included in the Schedule.

Show Spread

If this box is ticked the spread of the plants, as entered in the Label Existing
Plant command, will be included in the Schedule.

Show Status

If this box is ticked the Status 1, Status 2and Comments text, as entered in the
Label Existing Plant command, will be included in the Schedule.

Show Borders
If this box is ticked, border lines will be generated for the Legend.

With Border Lines Without Border Lines

Existing Vegetation Existing Vegetation

No Species Trunk Diam Height No Species Trunk Diam Height

51 Ac bu 100mm 3000mm S1 Ac bu 100mm 3000mm
S2 Ba er 7amm 4000mm 52 Baer 75mm 4000mm
T3 Eu ma 300mm 10000mm T3 Euma 300mm 10000mm
T4 Scac 200mm 7000mm T4 Scac 200mm 7000mm
T5 An co 300mm 12000mm Ta Anco 300mm 12000mm
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Inserting the Schedule

Whenthe OK button is clicked, you are prompted to “Locate the position of the
tree schedule”. This is the top, left corner of the Schedule. A single click will
generate the Schedule.

A sample Schedule is shown below.

Existing Vegetation

No Species Trunk Diam Height Spread Status

31 Ac bu 100mm 3000mm 3000mm Retain

S2 Ba er amm 4000mm 3000mm Retain

T3 Euma 300mm 10000mm | 6000mm | Retain

T4 Sc ac 200mm 7000mm 3000mm Remove

T5 An co 300mm 12000mm 7000mm | Almost Dead Remove Permission required

Note: The Schedule does not automatically update if you add or delete plant
labels after inserting it. To update the Schedule simply run this command
again (it will remember how you set it up last time) and click the top, left
corner of it.

You can, of course, click somewhere else if you want to re-positionthe
Schedule.

You do not need to delete the existing Schedule before updating it.
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Insert Proposed Plant
PURPOSE: Toselect andinsert afigure to represent the plant(s) you are
proposing for a landscape plan.

The appropriate type of plantcan be searched for and already inserted plants
can be replaced.

When the command is selected, the following dialog box is displayed.

Insert Proposed Plant

Selected Items:

In... | abbreviation | botanical name famil: COMMON name Cultivars favourites | type habit =

33 Acha Acacia bailepana Fabacea.. Cootamundra‘w... ‘Purpures’, Aurea’ Tree

34 Achu Acacia bugifolia Fabacea.. BoxLeaf Wattle Shrub

3/ Acde Acacia decurens Fabacea.. Eaily Black Wattle Tree

36 Acsa Acacia sowdeni “westemn Myall Tiee

37 Acsp Acacia spetabiliz Prostate Wattle

38 Acre Acer iubrum Fied Maple -
K ,

[rrsert e Blant | [Drelete Flant | Saye Datalase | Fieload Database | " Allow Editing
Search Fields:
= —Plan

Field .Name I Operator I Malue |i| Basic Figure: (& Dretailed Figure:

plan figure name |

elev. figure name e

3D figure name

image file name

detail plan figure name

detail elev. figure name

eley. image file name

line type

hatch pattern ;I

Seaich Reset
- Elesvation/30
Basic Figure: Detailed Figure: Image:
.?:,
Inzert Figur 9;
—
Diameter  |Default 'l :r: h;;
EH—
)
® & &) — e
— St s,
— . : 0 RN
1 Paint 2 Paints | Scale 2 Paints | —_— ?'ﬁt‘

Fieplace | Cancel |

This command also lets you edit your LANDWorksCAD Excel plant database
from within LANDWorksCAD. This is explained at the end of this section. For
details on editing your plant database directly in Microsoft Excel, referto
Appendix 2 — Editing the Plant Database in Excel on page 141.
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Selecting a Proposed Plant

The “Selected Items” area at the top of the dialog box lists the plants defined in
the “Plants” tab of your LANDWorksCAD Excel plant database. This database is
called LandworksPlantDatabase.xls and is found in the LANDWorksCAD folder
on your computer. Refer to Appendix 1 — The LANDWorksCAD Plant Database
on page 129 for more details on the database.

Selected ltems:

COMMON Name Cultivars favourites

.. | abbreviation | botanical name

Acacia balleyana Fabacea.. Cootamundra'w.. ‘'Purpurea’. ‘Aures’
34 Achu Acacia busifolia Fabacea.. Box Leaf'wattle Shiub
3B Acde Acacia decurrens Fabacea... Early Black 'Wattle Tree
3B Acsa Acacia sowdenii Western Myall Tree
Aizp Acacia spetabilis Prostate 'w attle

Acer mibrum Fed Maple - |
»

Note: The buttons just below the selecteditems area, ie, “Insert New Plant”,
“Delete Plant”, etc, let you edit your plant database from within
LANDWorksCAD and are explained later in the section entitled Editing
Proposed Plants from within LANDWorksCAD on page 64.

Scrolling down will show more plants; scrolling sideways will show more data for
the plants.

Click once anywhere in the row of data for the plant you want. Preview images
of the plant will be displayed in the six, bottom, right hand boxes. Not all of the
boxes will necessarily display previews; it depends on what has been defined in
your LANDWorksCAD Excel plant database.

The top row of previews shows three waysthe plan view of the plant can be
displayed in the drawing. You can switch between these displays whenever you
want to after the plant has been inserted —refer to the Plant Display Switching
command on page 81.

— Plan
Basic Figure: 1+ Detailed Figure: € Image:

-:'::,.

The “Basic Figure” and “Detailed Figure” previews are of LANDWorksCAD
drawingfiles, ie, they must have been drawn in LANDWorksCAD or created in
another CAD program and then imported and saved in LANDWorksCAD.
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The “Image” preview is of a JPG or BMP (bitmap) format file. This could be an
actual photograph of the plant or it could be an artistic representation that has
been created outside of LANDWorksCAD using image editing software, eg,
Photolmpact. The JPG format is preferred because file sizes are much smaller.

Having three ways of displaying the plan view of the plant gives you maximum
flexibility in how you present your landscape drawings, eg, for conceptplans,
construction plans, presentation plans, etc, and, as stated earlier, you can switch
between them whenever you want to.

It is up to you to decide just how “basic” the basic display is or how “detailed” the
detailed display is. Either can be as simple or as complex as you wish.

Likewise it is up to you to decide if the image display is an actual photograph or a
computer generated image.

All three plan displays do not have to be created for every plant, though
obviously you must use at least one or nothing will be displayed on the screen.

The plan display to be inserted can be selected by clicking in the white dot above
the preview so that a smaller black dot appears within it.

The information explained above also pertains to the Elevation/3D previews; the
Basic and Detailed figures are LANDWorksCAD drawing files and the Image is a
JPG or BMP file.

— Elevation/3D
B asic Figure: [retailed Figure: Image:

P P i
[
p——

—_—

:

Y.

ok
i

i
3
.s.

Note: The Elevation/3D figures cannot be inserted using this command. They
can be generated automatically via the Insert 3D Plants command (page
114) or inserted manually (refer to “Figure and Group commands” in the
RealCAD-V5 Reference Manual for more information on manually inserting
figures).
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Inserting the Selected Proposed Plant
Inserting the selected proposed plant is a two step process:

1. Select the diameter of the plant,

2. Insert the plant using the appropriate insertion method

— Inzert Figure

Dliamneter IDefauIt - I

o o 9

1 Paint I 2 Foints | Scale 2 Pointz |

Select the Diameter of the Plant

The diameter of the plant can be selected from the “Diameter” box, as shown
below:

— Inzert Figure

Drefaul

2R00.0 —|
a00.0
| Scale 2 Paointz |

Diameter

o

1 Paint

If the required diameter is not listed it can simply be typed directly into the box.

The word “Default” means the plant will be inserted at the size it was originally
drawn.

55



LANDWorksCAD V5 Manual

Insert the Plant Using the Appropriate Insertion Method

Once the diameter has been selected, the plant can be inserted into your
drawing in three different ways: “1 Point”, “2 Points” or “Scale 2 Points”. These
methods are explained below.

1 Paint |or @

Clicking either of these buttons attaches an image of the plan view of the plant to
your crosshair and the plant is inserted where you click your left mouse button.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won't actually appear until you click.

2 Paints | a |
or

Clicking either of these buttons attaches an image of the plan figure of the plant
to your crosshair, but two mouse clicks are required to insert it. The first mouse
click positions the plant figure; the second click defines the orientation of the
plant, ie, you can spin it around.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won’t actually appear until you click.

Scale 2 Points | ﬁl
or

Clicking either of these buttons attaches an image of the plan figure of the plant
to your crosshair, but two mouse clicks are required to insert it. The first mouse
click positions the plant figure; the second click defines the orientation and size,
or scale, of the plant, ie, you can spin it around and you can also make it larger
or smaller than the original image.

Note: If inserting the image, a rectangle will be displayed on the crosshair; the
image won't actually appear until you click.

This technique ignores the Diameter box.
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Note: If a plant has not been selected before any of these buttons are clicked,
the following dialog box will be displayed, indicating that a plant must be

LANDWorksCAD V5 Manual

selected from the “Selected ltems” list.

Tip: If you want to insert more copies of a plantthat you have already inserted
you don’'t have to use this command again, you can simply copy the
plants. They will still be recognised as plants from your database. You

Select

Select an item from the list.

can use any of the standard ways of copying techniques:

Refer to the “RealCAD V5.x Reference and User Manual” for details on

The Translate (Copy) Entities command

The Copy Along command

The Copy Array command

The Edit > Copy and Edit - Paste technique

The CTRL+C and CTRL+V technique

The “drag the entity while holding down the CTRL key” technique

commands and techniques.
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Searching for Proposed Plants

You can search for the plant you want using the Search Fields part of the
command. You can search on any of the data inthe “Plants” sheet of your
LANDWorksCAD Excel plant database.

Search Fields:

Field Mame | Operatar | Y alue | -
plan figure name

elev. figure name

30 figure name

image file name

detail plan figure name
detail elev. figure name
elev. image file name
line type

hatch pattern LI

Search Rezet

The Field Name column lists every column from your database; the Operator
column controls the range of data you are searching for and the Value column
provides limits for the search.

The database can be search in two ways, although they are similar.

Method 1

Double-click on the desired Field Name. This activates the “Compare Field
Name Properties” dialog box as shown below. Here the “Type” field was
selected.

Field Mame
Operator I j
Yalue | =]

Cancel |

Select the type of search “Operator” from the drop-down list, as shown below.
Here “Equal” is selected.
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Compare Feld Name Properties
Field Marme Itype
Operator | j

Vake W
Greater Than

’: Less Than |_|

Mot Equal

Select the desired search “Value” from the drop-down list as shown below. Here
“Palm” is selected. The values in the drop-down list will vary depending on the
Field Name selected. The values are extracted from your database.

Field Mame It_l,lpe
Dperator IEquaI j

Walue | j
Conifer -
OFem

Grass
Ground Cover

Herb

Perennial % o

Shiub
Succulent l

- SR

Click OK to finish the process. Your Search Fields area will look as shown
below.

Search Fields:

Figld M ame | Operator | Yalue |:|
botanical name

farnily

COmMmarn namne

COmmon name 2

Cutivars

favourites

hiahit

te:-:tl._Jre _ j

Search | Rezet |

|

You may repeat the above steps with other Field Namesto create multiple

search criteria, eg, you might be searching for all palms that have a maximum
width great than 3000mm.
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When you're happy with the search criteria, click the “Search” button.
Selected Items area will change and display only the items that match the search
criteria. For example, the image below shows only Palms.

The

Selected ltemns: N
In... | abbreviation | botanical name | family | COMMOon Name | Cutivars | favourite: | type | habit =
51 Aral Archontophoeni= alesandrea Arecaceae  Alexandra Palm Palm
52 Arcu Archontophoenis cunningham...  Arecaceae  Bangalow Palm Syn. Seaforthia elegans Palm
80  Caac Caipentaria acuminata Carpentaria Palm Palm
93 Chlu Chiyzalidocarpus lutescens Arecaceae  Golden Cane Palm Syn. Dypsis lutescens, C. mada Palm
99 Coau Comline australiz Arecaceae  Dracena Palm Palm
111 Cyke Cycas kennedyana Cypcad Palm
158 Ligr Licuala Grandis Small Fan Palm Palm _ILI
4 »
| S—

The desired plant can now be selected from the filtered list and inserted as
described above.

Method 2

Click once on the desired “Field Name”. The Field Name will be highlighted as
shown below. Here the “Type” field was selected.

Search Fields:

Field Mame

| Operator

| Walue |

=l

COMMon Name
COmmon hame 2
Cutivars
favaourites

habit

tewture
maxirnurm width
maxirmurm height

Search

Fezet

[

[

Click in the green highlighting line under the “Operator” heading. A drop down
field will appear as shown below.

Search Fields:

Field Mame

| Operator

| Walue |

=l

COMMon Name
COmmon hame 2
Cutivars
favourites

habit

tewture
maxirnurm width
maxirmurm height

Search |

Fezet |
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Select the type of search “Operator” from the drop-down list, as shown below.
Here “Equal” is selected.

Search Fields:

Field Mame | Operator | Walue |;|
COMMON Name

Common name 2 |
Cutivars

fawourites

habit
texture
maximLm width

maximurn height E;éf?ﬁ::_l

Greater Than

Search |

Now click the green highlighting line under the “Value” heading. A drop down
field will appear as shown below.

Search Fieldz:

Field Mame | Operator | Walue |;|
COMMMar Name

COmmon name 2 _I
Cutivars

fawaurites

e ]
habit

texture
maximLm width
maximurn height LI

Search | Fezet |

Select the desired search “Value” from the drop-down list as shown below. Here
“Palm” is selected. The values in the drop-down list will vary depending on the
Field Name selected. The values are extracted from your database.
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Search Fields:

Figld Mame | Operator | Walue |i|

COmMMoN name
COmmon hame 2 _|
Cutivars

favourites

habit I :|

Succulent -
Perennial

terture
rasimum width

maxirmum height

Search | Fezet |

Your Search Fields area will look as shown below.

Search Fields:

Figld Mame | Operator | Walle |i|

COMMon Name
Common name 2 _I
Cutivars
favourtes

Falry -
habit
terture
rasimum width

maximum height ;I

Search | Fezet |

You may repeat the above steps with other Field Names to create multiple
search criteria, eg, you might be searching for all palms that have a maximum
width great than 3000mm.

When you're happy with the search criteria, click the “Search” button.
Selected Items area will now display only the items matching the search criteria,
eg, the image below shows only palms.

Selected ltems:

The

| habit =

In... | abbreviation | botanical name | family | COMMON Name | Cutivars | favourites | type
51 Aral Archantophoenix alesandrea Arecaceas  Alexandra Palm Palm
B2 Arcu Archontophoenis cunningham...  Arecaceae  Bangalow Palm Syn. Seaforthia elegans Palm
80  Caac Caipentaria acuminata Carpentaria Palm Palm
93 Chlu Chiysalidocarpus lutescens Arecaceae  Golden Cane Palm Syn. Dypsiz tescens, C. mada... Palm
99 Coau Comline australiz Arecaceae  Dracena Palm Palm
111 Cyke Cycas kennedyana Cycad Palm
158 Ligr Licuala Grandis Small Fan Palm Palm
4
—

s

The desired plant can now be selected from the filtered list and inserted as
described above.
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Resetting the Search Criteria

To clear the filtered list of plants and display all the plants in the database again,
click the “Reset” button and then click the “Search” button.

Replacing Already Inserted Proposed Plants

The “Replace” button lets you replace plants that have already been inserted into
the drawing with other plants from the database.

This can be done in either of two ways:
1. You can select the plants to be replaced and then run the command, or

2. You can run the command first and then select the plants to be replaced

The two methods are nearly identical. The main difference is in how you can
select the plants to be replaced.

Select the plants to be replaced and then run the command

Step 1 — Select the plants that have already been inserted into the drawing.
You can use any selection technique for this.

Step 2 — Run the “Insert proposed Plant” command (this command).
Step 3 — Select the replacement plant from the “Selected Items” list.
Step 4 — Click the “Replace” button.

The selected plants will be replaced.

Run the command first and then select the plants to be replaced
Step 1 — Run the “Insert proposed Plant” command (this command).
Step 2 — Select the replacement plant from the “Selected Items” list.
Step 3 — Click the “Replace” button.

Step 4 — Select the plants that have already been inserted into the drawing.
You can only select plants one at a time using this method.

The selected plants will be replaced.
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Editing Proposed Plants from within LANDWorksCAD

The buttons and tick box displayed just below the “Selected Items” area let you
edit your plant database from within LANDWorksCAD. This means you don’t
actually have to know anything about Microsoft Excel to be able to edit your
database. ©

However, your plant database can also be edited directly in Microsoft Excel.
Referto Appendix 2 — Editing the Plant Database in Excel on page 141 for
details.

Selected [tems:

COMMaN harme Cultivars favourites

.. | abbreviation | botanical narme

Fabacea.. Cootamundia®...

Acacia baileyana ‘Purpurea’, ‘Burea’
34 Achu Acacia bugifolia Fabacea.. Box Leaf Waltle Shrub
3 Acde Acacia decurrens Fabacea.. Early Black \Wattle Tree
B Acsa Acacia sowdeni western Myall Tree

A sp Acacia spetabilis Prostate \Wattle

Acer rubrum Fed Mapls _Ij
»

Irserthl e Bl Ent | elete Blant | Saye [Natatase | Feload Database | ™| Allow Editing

When the dialog box is displayed, the buttons giving you access to the plant
database — “Insert New Plant”, “Delete Plant” and “Save Database” — are
“greyed-out”, ie, they are not accessible. This is to avoid plant databeing
accidentally edited. The “Reload Database” button is available in case the
database has been edited in Excel while LANDWorksCAD is open.

Important Note

You can edit the database in Excelwhile LANDWorksCAD is
running, but you cannot and must not edit the database from within
LANDWorksCAD while the database is open in Excel.

work in Windows — you cannot work on the same file, at the same
time, with two different programs. If the database is open in Excel
when you save it from LANDWorksCAD, you will get an error
message and LANDWorksCAD will lock up or crash.

I
I
I
I
I
| This is not a limitation of LANDWorksCAD; it is a simply how files
I
I
I
I

To activate the greyed-out buttons and allow editing of your plant database, click
the “Allow Editing” box, sothat a tick is visible. The buttons will then look like
this:

Irisert Mew Flant | Delete Flant | Save Datahaze | Reload D atabase | Iv Allaw Editing

You can also edit plants that are already in the database, although there is no
specific button for this.
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The editing functionality is explained below:

Edit a Proposed Plant already in the Database (no button)

To edit the botanical data of a plant already in the database simply click on the
text and edit it. The row of data will be highlighted in green, except for the
specific text to be edited, which will remain white for ease of typing.

You can also press the Tab key to move to the next column.

Some columns provide a list of data to choose from, indicated by a downward
pointing triangle. Clicking on the triangle displays the list, as shown below:

favourntes

Cultivars

Purpurea, Aurea

arazs
Ground oo
Herb

When such a list is available you cannot type in something that is not already in
the list; you can only select data from the list. You can, however, edit and add to
the list by editing the database in Excel.  See Appendix 3 — Working with the
Selection Data on page 143 for details on doing this.

To change the figure or image file for the plant, simply click in the relevant
preview box and the following dialog box will be displayed allowing you to browse
for the appropriate file.

Open | 7] ]
Laak in: I ) Flants j L] |‘=:F EH-
g Adiantum higpidulum-E.CAD @ Agapanthus proecos-E-BAKT
g Aezculus pavia. CAD @ Allocazuaning torulosa. CAD
g Aesculus pavia-E.CAD @ Allocasuarning torloss-E.CAD
g Agapanthus proecox. CAD @ Alnuz alutinoza CAD
g Agapanthuz proecox-BAK 1 cad @ Alnus glutinoza-E.CAD
g Agapanthuz proecox-E.CAD @ Amelanchia grandiflora, CAD
4] [ i
File name: | Open I
Files af tppe: Il:ad Files *.cad j Cancel |

™ Open as read-only
v
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When you have found the file, select it and click the Open button. The file will
then be displayed in the preview box.

When you select a plant figure or image using this technique, LANDWorksCAD is
editing data to columns you can't see, “behind the scenes”. This data is the path
and filename of the selected figure/image file. If you cancel the dialog box, the
following message will appear:

Clear Filename E2

Do you want to clear the filename for this item?

ez Mo |

Click the Yes button if you want to completely clear the filename data that was
entered, if any. Click the No button if you want to retain the filename data that
was there, if any.

Notes:

1. When browsing for figures, the “Files of type” section of the dialog box is
limited to “Cad Files *.cad” so you will only see LANDWorksCAD type
files. Elevation/3D figures have a “-E” at the end of their name for ease of
identification.

2. When browsing forimage files, the “Files of type” section of the dialog
box is limited to “Image Files *.bmp, *.jpg” so you will only see those
types of files. Elevation/3D image files have a “E” at the end of their
name for ease of identification.

3. Selecting the appropriate plant figure/image file is a simple process, but
there is one important prerequisite — the figure or image file must exist
before it can be selected, ie, it must have been drawn/created first.

I Important Note |
I When you have finished editing your plants, it is vitally important |
I that you save the changes to the database by clicking the “Save |

Database” button (see below). If you don't, you will lose the |
| changes. |
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Insert New Plant
There are two stages to inserting a new plant:
1. Entering the botanical data, and

2. Selecting the appropriate figures and image files

Entering the botanical data
When the “Insert New Plant” button is clicked, a blank row is inserted above the

plant that is currently selected in the “Selected Items” list. The relevant botanical
data for the new plant can then be typed in.

Selected |temns:

Ih... | abbreviation | botanical name | family | COMMoh hame | Cultivars | favourites | tupe | hakit :I
32 Abar Abies grandis Grand Fir Canifer —
33 Acha Acacia ballepana Fabacea. Cootamundra'w.. Purpurea, Aurea Tree

34

35 Achu Acacia busifolia Fabacea.. Box Leaf'Watlle Shrub

36 Acde Acacia decurens Fabacea... Early Black ‘Waltle Triee

7 Acsa Acacia sowdenii ‘whestern Myall Tree

38 Acsp Acacia spetabilis Prostate wattle _ILI
4 3

™ lnsert Mew Flant Delste Plant | Save Database | Reload Database | IV &llow Editing

To enter the botanical data, click on the blank row, in the column you want to edit
and type in the required data. When you select the blank row it will be
highlighted in green, but the part of the row in the column you selected will
remain white.

You can also press the Tab key to move to the next column.

Some columns provide a list of data to choose from, indicated by a downward
pointing triangle. Clicking on the triangle displays the list, as shown below:

Cultivars favourntes

Purpurea, Aurea

Fem
arazs
Ground oo
Herb

When such a list is available you cannot type in something that is not already in
the list; you can only select data from the list. You can, however, edit and add to
the list by editing the database in Excel. See Appendix 3 — Working with the
Selection Data on page 143 for details on doing this.

Multiple new plants can be inserted by simply clicking the button again and
entering the data.
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It's up to you to decide how much data you enter. Mostcolumns are not
compulsory. Refer to Appendix 1 — The LANDWorksCAD Plant Database on
page 129 for details on the database.

Selecting the appropriate figures and image files
Once the botanical data has been entered, appropriate LANDWorksCAD figures
and image files must be selected to represent the plant in the drawing.

To select the plant figure or image file, simply click in the relevant preview box
and browse and select the appropriate file, as described in the Edit a Proposed
Plant already in the Database (no button) section above.

Note that not all the preview boxes have to be filled in, but at least one must be,
otherwise there will be nothing to see when the plant is inserted. ©

The Elevation/3D figures and images are not required at all if you are only
working in 2D.
I
| Important Note |
| When you have finished inserting your plants, it is vitally important |

| that you save them to the database by clicking the ‘Save |
| Database” button (see below). If you don’t, you will lose them.

Delete Plant

To delete a plant, select the plant by clicking anywhere in its row and then click
the “Delete Plant” button. The following confirmation dialog box will appear (with
the appropriate plant name, of course)

Delete Plant

Delete plant Landzcape-SymbalzhFlantshdeplenium Midus. CAD?

ez Mo |

Clickthe Yes button to confirm you want to delete the plant from the database.
Click the No button if you do not want to delete the plant.
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When you have finished deleting plants, it is vitally important that |
you save the changes to the database by clicking the “Save |
Database” button (see below). If you don't, the plants will not be

Save Database

After you have done any editing, inserting or deleting of plants, you should click
the “Save Database” button so the changes are stored permanently in the
database. If you don't, the changes wil not be remembered by
LANDWorksCAD, ie, plants you thought you added to the database will not be
there, plants you thought you deleted will still be there, etc.

Reminder Note

You can edit the database in Excel while LANDWorksCAD is
running, but you cannot and must not edit the database from within
LANDWorksCAD while the database is open in Excel.

work in Windows — you cannot work on the same file, at the same
time, with two different programs. If the database is open in Excel
when you save it from LANDWorksCAD, you will get an error
message and LANDWorksCAD will lock up or crash.

|
|
|
|
|
| This is not a limitation of LANDWorksCAD:; it is a simply how files
|
|
|
|

Reload Database

Clicking the “Reload Database” button forces LANDWorksCAD to re-read the
plant database and show any changes that have occurred since
LANDWorksCAD started.

This would be necessary ifthe database was edited in Excel while
LANDWorksCAD was running.

It would also be necessary if you have been editing the plant database from
within LANDWorksCAD and have made a few mistakes (it does happen! ©) and
want to start again.
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Label Proposed Plant
L

PURPOSE: To label proposed plants inserted from the LANDWorksCAD Excel
plantdatabase (usingthe Insert Proposed Plant command — refer to previous
section) for identification on the landscape drawing.

You can select the plant(s) to be labelled before or after running the command.
Refer to the Number of plants section on page 71.

When the command is selected, the following dialog box is displayed.

Label Proposed Plant |
Mumber of plants |3 Include Mumber v
Label field name II:u:utaniu:aI name j
Terminator type IFiIIEu:I Arro j
Terminator weight IDEfauIt j

Terminatar size |4. 1] [
Test size |5. aa i

Scale text by the plot scale [+
Label with leader lines v

Cancel |

An example of a label is shown below. It shows the botanical name of the plants,
how many there are, a leader pointing to one of the plants and a connecting line.
Not all these components are compulsory.

/3 x Abies grandis
|
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Number of plants

This box displays the number of plants that were selected prior to running the
command. If no plants were selected prior to running the command this box
displays 1 and you can only label one plant at a time. This box is not editable.

Note: If you select multiple plants prior to running the command, make sure that:

1. You select only plants, and

2. You select the same type of plant

If you select entities other than plants, eg, lines or circles, the following
warning box will be displayed. LANDWorksCAD can only label plants.

Label

Only multiple plants can be selected

If you select more than one type of plant, eg, an Acacia buxifolia and an
Acacia snodenii (which can look similar on the screen, depending on the
figures used to represent them) the following message box will be
displayed. LANDWorksCAD can only label one botanical name at a time.

Label

Only plants that are the same should be selected.
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Include Number

If this box is ticked, the number of selected plants will be included in the label. If
the box is not ticked, the number will not be displayed. In the examples shown
below, two plants were selected for labelling — the top example had the box
ticked, while the bottom example did not.

¥
e

Label Field Name

This box lets you choose what data from the plant database is used to identify
the plants. In the examples and dialog box above the botanical name was used,
but any field from your plant database can be used, eg, abbreviation or common
name. Clicking on the triangle at the end of the box displays a list of the fields
from your plant database, as shown below:

2 x Abies grandis

Abies grandis

Label Proposed Flant Ed |

Mumber of plants |3 Incziude Number Iv

Label field name batanical name

Terminator bppe

climate group

Terminator weight | 50Mmman nanme
common name 2

Terminator size containgr size
Cultivars
Test size dengity
dezcription 2
Scale test by the pld dezcription test W

Label with leader linez v

coree_|
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Terminator Type

This box lets you choose what type of terminator you want on the end of the
leader lines (if you use them). Clicking on the triangle at the end of the box
displays a list of the terminator types. There are seven to choose from and they
are shown below.

Terminator Type Display

None /fAbles grandis
Arrow [AbIES grandis

Open Arrow /ﬁ'—\bles grandis
Filled Arrow f Abies grandis

Dot [Ables grandis

Filled Dot Abies grandis

Abies grandis
Slash f

Terminator Weight

Leader lines, ifused, are drawn with the current line weight. This box lets you
choose an alternate weight, or thickness, of the lines that make up the
terminator. Clicking on the triangle at the end of the box displays a list of the
available weights; they range from 0 to 3.0mm. There is also a “Default” option,
which means the terminator lines are drawn with the same weight as the leader
lines. The examples shown below have a current line weight of 0.25mm.

Default 0.50 1.50

[Abies grandis [Abies grandis [Abies grandis
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Terminator Size

This box lets you choose the size of the terminator. This is the length of the
arrow or slash, or the diameter of the dot.

Text Size

This box lets you define the size of the label text. Text size is influenced by the
next option, Scale Text by the Plot Scale and can work in either of the following
two ways

1.

If the Scale Text by the Plot Scale option is ticked, then the text size
entered is automatically multiplied by the view’s Plot Scale and the text is
displayed on the screen at that scaled size.

For example, if a text size of 4mm is entered and the Plot Scale is 100, the
text will be displayed on screen at 400mm high.

This technique lets you define the text size based on the height you want it
to be when it is printed on paper. If the Plot Scale is changed for some
reason, the on-screen text height will automatically adjust, but, providing
you print the drawing at the specified Plot Scale, the text will always print
at the height specified.

For example, a text height of 4mm and a Plot Scale of 100 produces on-
screen text at 400mm high. Printing the drawing at a scale of 1:100 will
produce text 4mm high on the paper. Change the Plot Scale to 200 and
the on-screen text will become 800mm high, but printing the drawing at a
scale of 1:200 will still produce text 4mm high on the paper.

Ifthe Scale Text by the Plot Scale option is not ticked, then the text size
enteredis the on-screen height. It is not, in any way, affected by the
view’s Plot Scale.

For the text to be visible on the screen, the size must be calculated
accordingly.

This technique will produce printed text of a different size if the Plot Scale
is changed.

For example, if a text height of 400mm is specified and the Plot Scale is
100, the printed text will be 4mm high, but if the Plot Scale is changed to
200, the printed text would be 2mm high.
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Scale Text by the Plot Scale

This tick box controls whether the text size entered is automatically multiplied by
the view’'s Plot Scale for on-screen display. Refer to the previous section, Text
Size for more details.

Label with Leader Lines

This tick box controls whether leader lines are displayed for the label. The left
hand example below shows a label with leader lines; the right hand example
shows a label without leader lines.

/—Abies grandis
Abies grandis

Inserting the Label

When the OK button is clicked, you can insert the label. The steps required to do
this will vary depending on what options were set in the dialog box.

For example, assume the dialog box was filled in as shown below.

Label Proposed Plant |
Murmber of plants |3 Include Mumber v
Label field name II:u:utaniu:aI harme j
T erminatar type IFiIIeu:I Ao j
T erminator weight I D efalt j

Terminator zize |4.EIEI T
Text zize IE.EIEI i

Scale text by the plot scale [
Label with leader lines v

Cancel |
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The steps required to insert the label would be as follows:
1. Locate the start of the leader (the tip of the terminator)
2. Locate the corner of the leader
3. Locate the end of the leader

The label text is inserted automatically at the end of the leader line.

An example of the resultant label might be as shown below. The ®®@® labels
correspond to the three steps above.

ﬁi& x Abies grandis
]

! @

The line joining the selected plants is inserted automatically and joins the origin
points of the plants. It is inserted with the active colour, layer style and weight.

If the plants had not been selected prior to running the command, you would be
prompted to select a single plant before inserting the label

If the “Label with leader lines” option was not ticked, you would only be prompted
for the location of the text.

After the label has been inserted, the command remains active, letting you label
more plants using the same settings, although only one plant at a time can be
labelled.

Tip: Holding down the Shift key while selecting the leader points will constrain
the leader lines to be either 0° (horizontal), 45° or 90° (vertical).

Tip: To create a purely horizontal (or vertical) leader, hold down the Shift key
and simply draw the leader in a straight line.
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Proposed Plant Legend

LEGEMD

PURPOSE: To automatically generate a Legend of all the proposed plantsthat
have been inserted in the drawing.

A sample Legend is shown below.

Proposed Plants

‘ abbreviation botanical name common name Qty
Pal‘m
;}-“%- Ar al Archontophoenix alexandrea Alexandra Palm 6
* Ar cu Archontophoenix cunninghamiana Bangalow Palm 4
O Ph ro Phoenix roebelenii Dwarf Date Palm .3
Shrub .
O Gr ho Grevillia hookerana Red Toothbrushes .4
O Grle Grevillia leucopteris White Plume 10
Tree
C)‘ An co Angophora costata Red Gum 3

When the command is selected, the following dialog box is displayed.

Legend Fields:
Field Mame | Diizplay | il
abbreviation Yes
abbreviation-2 Mo
botanical name: Yes J
farmnily Yes
COMMon name Yes
COMMan narme 2 Mo
Cutivears Mo
favourites Mo
tipe Mo
habit Mo
texture Mo
rnaximurm width Mo
maximum height ez
maturity age Mo LI
Heading IProposed Plarts
Group by It_l,lpe j
¥ Show Borders
[ Show Relative Size
V¥ Show Quantity
[V Show Quantity Last
Table Size I'I 200 il
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Legend Fields

This part of the dialog box lets you selectthe botanical data that you want
displayed in the Legend. Every column that is in the LANDWorksCAD plant
database is listed here.

Double-click on a field name to toggle its display status between Yes and No. All
field names marked ‘Yes’ will be included in the Legend.

Heading

Text typed in this box will be displayed at the top of the Legend as a heading. If
you do not want a heading leave this box blank.

Group By

The plants in the Legend can be grouped by any of the field names. For
example, if the plants were grouped by Type, all the shrubs would be listed
together under a sub-heading of “Shrub”; all the trees would be listed together
under a sub-heading of “Tree”, etc. Any field name can be used to group the
plants.

The example below shows the plants grouped by Type.

Proposed Plants
‘abbreviation botanical name

%é'i Aral Archontophoenix alexandrea

% Arcu Archontophoenix cunninghamiana

O Fhro Fhoenix roebelenii
'Shrub

O Grho Grevillia hookerana

O Grile Grevillia leucopteris
»Tree

O‘ Anco Angophora costata
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Show Borders
If this box is ticked, border lines will be generated for the Legend.

With Border Lines Without Border Lines

Proposed Plants Proposed Plants

Show Relative Size

The Legend displays a plan figure for each plant and, by default, automatically
scales the figures to fit into the given row height so they are all the same size. If
this box is ticked, however, the figures are scaled in size relative to each other.

Not Ticked Ticked
|
Palm

y d %&Aral
m #|Arcu

Note the difference in size of the “Ph ro”.

I
m

Fal

Tip — If you insert a Legend with this option ticked and some of the plan figures
don’t appear, it is most likely because those plants are much smaller on
the drawing than the other plants and so are tiny when inserted into the
Legend. They are there; they're just so small you can see them! ©

Show Quantity

If this box is ticked, the second column in the Legend will show the quantity of
each plant, ie, LANDWorksCAD will count your plants for you!

Show Quantity Last

If this box is ticked, the quantity figures will be in the last column of the Legend,
not the second.
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Table Size

This box controls the height, in mm, of each row in the Legend. It should be
adjusted to suit the scale of the drawing you are creating.

A simple “rule of thumb” to determine a suitable size for the table is as follows:

1.

2
3.
4

Decide how high you want the Legend text to be when printed, eg, 4mm
Add 2mm, to allow a 1mm space above and below the text, > 6mm
Multiply that number by the Plot Scale, eg, a Plot Scale of 200 gives 1200

Use this final number as the “Table Size”

Inserting the Legend

When the OK button is clicked, you are prompted to “Locate the position of the
legend”. This is the top, left corner of the Legend. A single click will generate

the Legend.

A sample Legend is shown below.

Note:

Note:

Proposed Plants

‘ abbreviation botanical name common name Qty
Paim
;};"g‘ Ar al Archontephoenix alexandrea Alexandra Palm 8
* Ar cu Archontophoenix cunninghamiana | Bangalow Palm 4
O Ph ro Phoenix roebelenii Dwarf Date Palm .3
Shrub .
O Gr ho Grevillia hookerana Red Toothbrushes :4
O Grle Grevillia leucopteris White Plume 10
Tree
C)‘ An co Angophora costata Red Gum 3

The Legend does not automatically update if you add or delete plants after
inserting it. To update the Legend simply run this command again (it will
remember how you set it up last time) and snap to the top, left corner of it.

You can, of course, click somewhere else if you want to re-positionthe
Legend.

You do not need to delete the existing Legend before updatingit.

The Legend is made up of lines and text and can be edited after it has
been inserted. Be aware, though, that any edits will be lost if you insert a
new Legend.
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Plant Display Switching

¢

PURPOSE: To display the plants as basic or detailedfigures or bitmap images,
regardless of how they were initially inserted.

All plants in the drawing can be changed automatically or selected plants only
can be changed.

When the command is selected, the following dialog box is displayed.

Plant View Switching |

Dizplay

Show B azic Figures (8
Show Detal Figures (o
Show Bitmap Images €

(]9 I Cancel

Select the required display type by clicking in the appropriate white dot.
When the OK button is clicked:
- if plants were selected prior to the command being run, then onlythose
plants are changed,

- if noplants were selected prior to running the command, the following
confirmation dialog box is displayed:

Plant View Switching

Maodify all plants?

Yes Mo |

If the Yes button is clicked, all the plants in the drawing are changed.

If the No button is clicked, the command is cancelled.

Note: If a drawing contains many plants, changing their display to bitmap images
can take a while and subsequent repaints may be slow. It is suggested
that plants be displayed as bitmap images only when necessary, eg, for
printing or when presenting to clients.
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Tally

o1
%

PURPOSE: To extract data from the drawing for estimating and quoting. The
extracted data is:

the number of plants

the lengths of linear entities (lines, arcs, circle and curves)
areas of planes

Sub-totals and totals for the above

When the command is selected, the data is written to a temporary file called
“quantities.txt”, which is immediately displayed in Notepad.

Note: Quantities.txtis a temporary file. The same name is used every time the

command is run and therefore previous data is overwritten. If you want to
save the data in quantities.txt you must select File > Save As and save
the file to another location for later use.

Once saved, being a standard “txt” file, itcan be opened in any text editor or
even Microsoft Excel or Word.

Tip:

Tip:

Only entities on “named” layers are counted and measured. Entities on
layers that have not been named are ignored. Refer to the RealCAD-V5
Reference Manual for information on named layers.

Only entities that are currently visible on screen at the time of running the
command are counted and measured. This lets you be selective about
whatinformation is extracted, eg, if only hardscape related layers are
turned on, only hardscape data will be extracted.

The data below is an example of the sort of data that is extracted by the Tally
command.

For ease of reading, the data has been colour coded, as follows:

Red text is the layer name.

Black text shows the length of linear entities.
Blue text shows the areas of planes.

Green text shows the plants and their quantities.

This colour coding does not occur in the quantities.txt file; all text is black.

Some notes have been added to suggest possible sources of the data.
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Kl'wo lengths of decq

Decking edging perhaps
2 X 4.000m
Area of decking
1 x16.000m2

Total length for Decking 8.000m
Total area for Decking 16.000m2

Gardens //ﬁen th of garden edgin
1 x28.447m ° ’ o

Acacia sowdenii (Western Myall) 5
Acer rubrum (Red Maple) 5
Anigozanthos manglesii (Mangles Kangaroo Paw) 6
Asplenium nidus (Birds Nest Fern) 4
Total length for Gardens 28.447m
Total plants for Gardens 20

Mulch ﬁ///Multi ly by the depth and
1 x153.201m e got :

“ you've got the volume of
mulch required

Total area for Mulch 153.201m2

Paving
2 x 6.000m
2 x 1.500m

1 x 9.000m2
Total length for Paving 15.000m

Total area for Paving 9.000m2

Total length  51.447m
Total area 178.201m
Total plants 20
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Insert Grid Lines

PURPOSE: Todraw a construction grid on the drawing, with row and column
labels.

A sample grid is shown below.

OO,

(o)

©,®

ONONONONG

When the command is selected, the following dialog box is displayed.
Grid options |
# Spacing 2000.0
Y Spacing 2000.0
= Extension 1000.0
" Extenzion 1000.0
T ext zize A00.0 i

111

Circle text

Labels between giid nes [V

Cancel

d

84



LANDWorksCAD V5 Manual

The image and text below explain the options in this dialog box.

Y Extension @ @ @

Y Spacing

®
F@@@OO

X Spacing X Extension

X Spacing

This box lets you define the horizontal distance, in mm, between the vertical lines
of the grid.

Y Spacing

This box lets you define the vertical distance, in mm, between the horizontal lines
of the grid.

X Extension

This box lets you define how far the horizontal grid lines extend past the first and
last vertical grid lines.

Y Extension

This box lets you define how far the vertical grid lines extend past the first and
last horizontal grid lines.

Text Size

This box controls the height, in mm, of text used as the row and column labels. It
should be adjusted to suit the spacing of the grid lines.
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Circle Text

If this option is ticked the text used as row and column labels have a circle drawn
around them, as shown in the example above.

Labels between grid lines

If this option is ticked the row and column labels are positioned between the grid
lines as shown in the example above. If it is not ticked the labels are placed at
the end of the grid lines, as shown below.

oNoNoNoNoNG

©@OO0OO0

Inserting the Grid

When the OK button is clicked you are prompted to locate the lower left corner
and upper right corner of the grid. As you drag your crosshair across the
screen the grid is dynamically displayed so you know how it is going to look.

The grid is drawn immediately the upper right corner is selected.

The grid lines and circles are drawn using the current colour, layer, style and
weightsettings. The text is drawn with the current text settings. It is highly
recommended that the grid be put on a separate layer so it can be turned of if
necessary.

When inserted, the grid is “grouped”, ie, selecting any part of the grid
automatically selects the entire grid. This makes it easy to work with the grid as
if it was a single item. You can “ungroup” the grid if you need to edit it. Referto
the RealCAD-V5 Reference Manual for more information on grouping.

Note: This grid is not the same as the standard RealCAD grid.
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Set Heights

PURPOSE: To assign height values to entities in your drawing, in preparation for
generating a 3D Digital Terrain Model (DTM) usingthe Insert DTM command
(see page 92).

For an entity to be used when generating a DTM it must have some sort of
height. This height can be an actual physical height, ie, a Z coordinate, or it can
be an “assigned” height, ie, a value assigned by this command.

Note: A height of O (zero) is still a valid height.

The entities having heights assigned to them would typically be representing
contours, spot heights, boundaries, landforms, etc.

Height values can be assigned to points, lines, arcs, circles and curves.

Note: Assigning a height to an entity does not physically move it to that height.
This command is also used to edit heights that have already been assigned.

If no entities have been selected prior to running the command, you are
prompted to select an entity and then the dialog box shown below is displayed.

If an entity or entities have been selected before running the command, the
dialog box shown below is displayed immediately.

Set DTM Height Data
OTH Data DT Test Label

DTH Height |‘|2EIEI Text zize |4 T

Siale test by the plat scale W

[ SetHeight Show Heights | Cancel |

Note: If you want to assign the same height to multiple entities it is more efficient
to select them before running the command. Once the command starts
you can only assign a height to one entity at a time.
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The text below explains the options in this dialog box.

DTM Height

This box lets you enter the required height value, in mm, that will be assigned to
the selected entity or entities.

If the entity or entities have never had heights assigned to them, 0.0 (zero) will be
displayed.

If the entity or entities already have a height assigned to them, their height value
will be displayed.

Note: If you pre-select multiple entities that have different heights assigned to
them, the height of the first entity that had a height assigned to it will be
displayed.

Text Size

This box lets you define the size at which the DTM text label will be displayed on
the screen when you click the Show Heights button (see below). The text size is
influenced by the next option, Scale Text by the Plot Scale and can work in either
of the following two ways

1. Ifthe Scale Text by the Plot Scale option is ticked, then the text size
entered is automatically multiplied by the view’s Plot Scale and the text is
displayed on the screen at that scaled size.

For example, if a text size of 4mm is entered and the Plot Scale is 100, the
text will be displayed on screen at 400mm high.

This technique lets you define the text size based on the height you want it
to be when it is printed on paper. If the Plot Scale is changed for some
reason, the on-screen text height will automatically adjust, but, providing
you print the drawing at the specified Plot Scale, the text will always print
at the height specified.

For example, a text height of 4mm and a Plot Scale of 100 produces on-
screen text at 400mm high. Printing the drawing at a scale of 1:100 will
produce text 4mm high on the paper. Change the Plot Scale to 200 and
the on-screen text will become 800mm high, but printing the drawing at a
scale of 1:200 will still produce text 4mm high on the paper.

2. Ifthe Scale Text by the Plot Scale option is not ticked, then the text size
entered is the on-screen height. It is not, in any way, affected by the
view's Plot Scale.

For the text to be visible on the screen, the size must be calculated
accordingly.
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This technique will produce printed text of a different size if the Plot Scale
is changed.

For example, if a text height of 400mm is specified and the Plot Scale is
100, the printed text will be 4mm high, but if the Plot Scale is changed to
200, the printed text would be 2mm high.

Scale Text by the Plot Scale

This tick box controls whether the text size entered is automatically multiplied by
the view's Plot Scale for on-screen display. Refer to the previous section, Text
Size for more details.

Set Height

When this button is clicked, the height value entered is assigned to the selected
entity or entities. There is no visual indication of this, although the height values
can be displayed with the “Show Heights” button (see below).

After a height has been assigned you are prompted to select another entity to
assign a height to.

Show Heights

When this button is clicked the height values (DTM text labels) are displayed next
to each entity, at the text size specified, as shown below

When the height values are displayed, this button changes to “Hide Heights”
letting you hide them if you don’t need to see them any more.

4200 4300
4300
200
300
200 +

200 00
+777,200 200 +200& 200 ioo i

*

300 300
9 +300,300 300,300 *

1200
00

300

100
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Deleting Assigned Heights
The height values are attached to the entities as attributes. To completely delete
the attribute, and hence the assigned height, do the following:

For a single entity
1. Select the entity.
2. Select Edit > Delete Attribute from the menu.
3. lts attribute data will be displayed, similar to that shown below.

Attribute 1 of 1

Landworks: DT kD ata;: 1000, 0000,0.0000

o

Mest | Lazt | Deletel E it |

4. Click on the “Delete” button.
5. The following confirmation dialog box will be displayed.

Delete Attribute |

\1}) This entity has no attributes

6. Click “OK” to continue.

For multiple entities
1. Select the entities.
2. Select Edit > Delete Attribute from the menu.
3. The following confirmation dialog box will be displayed.
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Delete Attribute ]

Delete all the attributes from each of the selected entities

fes MNa |

4. Click “Yes” to delete all the attributes from each the selected entities. Click
“No” if you decide not to proceed.

Note: If you are an advanced user of LANDWorksCAD and have assigned your
own attributes to the entities in your drawing you should not use the
“Delete Attribute” command as it will delete ALL attributes from ALL

selected entities.
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If a selected entity has not been assigned a height value using the Set Heights
command (see previoussection), the ‘Insert DTM’ process uses the height at
which the entity was inserted, ie, its physical Z height. This is typically zero in 2D
drawings so it is important that all the selected entities have first had their real life
heights assigned.

Note: If an entity has an actual, physical heightand an assigned height, the
assigned height is used by this command.

The entities to be used in the creation of the DTM must be selected before the
command is run.

When the command is selected, the following dialog box is displayed.

Insert DTM

Cantaur Point Spacing L]

Mesh Size |2DDD

DTM Layer [DTH 1 I
DTk Colour I? Select Eolourl

T hsen OTHMT Inzert DTk with boundary | Cahcel |

The text below explains the options in this dialog box.

Contour Point Spacing

When generating a DTM, each selected linear entity (line, arc, circle and curve)
has temporary “contour points” defined along it. This box lets you define the
spacing between these contour points.

The spacing is in millimetres.

Smaller spacings generate more contour points and produce a more accurate
DTM shape.

However, smaller spacings also increase the amount of time it takes to generate
the DTM.

As a rule of thumb, a contour point spacing of 500 is a good value for a DTM of
an “average” block of land. If the DTM covers a larger area of land, it could be
increased.

Tip: If in doubt, use a larger value as it will generate the DTM more quickly and
make it easier for you to determine the appropriate value.
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Mesh Size

Mesh Size is the total humber of triangles use to generate the DTM. This box
lets you define how many triangles you want to use.

A higher number will give a more accurate DTM shape, but the DTM will take
longer to generate.

As a rule of thumb, a mesh size of 2000 is a good starting value fora DTM of an
“average” block of land. If the DTM covers a larger area of land, it could be
increased.

Tip: If in doubt, use a smaller value as it will generate the DTM more quickly
and make it easier for you to determine the appropriate value.

DTM Layer
This box lets you select the layer on which you want the DTM generated.

The layer can be selected from a list by clicking on the triangle at the end of the
box, as shown below.

insert DTM ]|

Contour Point Spacing IEDD
tesh Size |2DDD

DT Layer DT 1
DTk Colour =

TM 2
DTM 3
I DTH 4 |
Insert DT Insert DT DTM 5 - e

The listed layers are named layers and correspond to the standard
LANDWorksCAD numbered layers as follows.

Name Number Name Number
DTM 1 501 DTM 11 511
DTM 2 502 DTM 12 512
DTM 3 503 DTM 13 513
DTM 4 504 DTM 14 514
DTM 5 505 DTM 15 515
DTM 6 506 DTM 16 516
DTM 7 507 DTM 17 517
DTM 8 508 DTM 18 518
DTM 9 509 DTM 19 519
DTM 10 510 DTM 20 520
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DTM Colour
This box lets you select the colour with which you want to display the DTM.

The colour number can be typed directly into the box or it can be selected from a
palette by clicking on the “Select Colour” button, as shown below.

Insert DTM
Contour Point Spacing a00
Mesh Size 2000
DTH Layer DTH 1 j

DTr Colaur I? \ﬂacﬂj DIDUEI
=
x| Cancel |

Define |
Fezet Defaults |

B0 |E1 B2 B3 |64 [EG| BB 67

Ok | (w3 Cancel

Insert DTM button
Clicking this button generates the DTM based on the options entered into the
dialog box. No further user input is required.

Note: If the Contour Point Spacing is small and/or the Mesh Size is large, it may
take a few minutes to generate the DTM.

A sample isometric view of a DTM is shown below. The entities used to generate
the DTM can still be seen.
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The picture below shows four views of the DTM — Top, Iso, Front and Right.
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Insert DTM with boundary button

Clicking this button also generates a DTM, but you are prompted for two corners

f the DTM.

its the size o

mi

to define a rectangular boundary that |

In the image below, a rectangle has been drawn to show the proposed boundary.

Clicking on any two diagonally opposite corner points would generate the DTM

shown below.
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The isometric view below shows the full effect of the boundary on the DTM.
Compare it to the full DTM in the previous section.
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Modify DTM

PURPOSE: To allow modification of an existing DTM by a simple push/pull drag
method.

The DTM is modified by effectively dragging a cone shape slowly across it,
although the cone shape is not actually visible. The cone can push the DTM
down, like digging a hole or trench, or pull the DTM up, like building a mound of
dirt.

| Note: This command has only recently been released and is still undergoing
| intensive development. As such it is not yet fully functional. It was

| released with the intent of obtaining feedback from users. It will

| change in both format and function as it is developed.
|
|
|

Any comments and/or suggestions about this command are welcome.
Please send them to Error! Hyperlink reference not valid..

The following notes explain how the command works at the time of writing this
manual.

When the command is selected, the following dialog box is displayed.

Modify DTM ]|
Height Parameter 200
Area Parameter hDDU

Cancel |

The text below explains the options in this dialog box.

Height Parameter

This box lets you set the height or depth of the cone. Simply type in the value
required.

If the number is positive, the cone pulls the DTM up; if the number is negative,
the cone pushes the DTM down.
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Area Parameter

This box lets you define the size of the area that is affected by the cone. Simply
type in the value required.

Larger numbers will have a wider effect. It is like the base diameter of the cone.

When you click the OK button you are prompted to “Click and drag to modify the
surface”.

Hold down the left mouse button and drag your crosshair across the DTM to
“modify” it.

The following images demonstrate how the command works.

The first image below shows a small, flat DTM that is 10m wide by 7m high. Itis
flat only to demonstrate more clearly how this command works. The command
will work on any DTM.

B View Top - Scale 1:94.20 Plot Scole 1:100,00 IS [=1ES} | &= View Iso - Scale 1:113.24 Plot Scale 1:100.00
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Setting the height parameter to 500, the area parameter to 1000 and dragging
the crosshair slowly from point A to point B, gives the result shown below.

ra op - Scale 1:94.20 Plat

= 1:100.00 i

(= View Iso - Scale 1:113.24 Plot Scale 1:100.00
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Setting the height parameter to -500, the area parameter to 1000 and dragging
the crosshair slowly from point A to point B, gives the result shown below.

(=) op - Scale 1:94.21 = 1:100.00 DA [=TE] | &= View ko - Scale 1:113.24 Piot Scale 1:100.00
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The speed at which the crosshair is dragged across the DTM will affectthe
result. Slower speeds will result in a more continuous modification.

For the images shown above the crosshair was dragged across the DTM fairly

slowly. As a comparison, for the image below the crosshair was dragged across
the DTM fairly quickly.

View Top - Scale 1:94 20 Plol Scale 1:100,00 iz -_ I {Bn View Iso - Scale 1:113.24 Plot Scale 1:100.00

Extremely slow drag speeds can be used to exaggerate the modification. In the
image below, the crosshair was dragged very slowly from C to D.

(=17 | = View ko - Scale 1:113.24 Plot Scale 1-100.00

G2 View Top - Scale 1:94 20 Plot Scale 1:100,00
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Insert Batter

PURPOSE: To produce battered banks within an existing DTM.

The batter may represent the sides of aroad, a driveway, a building slab, a
swimming pool excavation, etc.

The batter can be created above and/or below the DTM.

The images below show before and after the blue “road” was put through the
DTM and the batter created by this command.
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The image below shows two more examples, one with hidden lines removed, the
othershaded, of the use of this command: a path twisting its way up a gentle
slope and a pool excavation. Virtually any shape can be constructed using the
“Insert Batter” command; it's just up to you to work out what you want! ©
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Toinsert a batter, a ruled surface that represents the landscaping feature (road,
driveway, slab, pool, etc) must first be inserted in the correct position. Refer to
the “RealCAD V5.x Reference and User Manual”, for information on Ruled
Surfaces.
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When the command is selected, the following dialog box is displayed.
Batter Banks |

Angle

ﬂ

Mezh Size 400

Cancel

d

The text below explains the options in this dialog box.

Angle

This box lets you define the angle of the batter. The angle is measured from
horizontal at the ruled surface.

The image below shows two examples of how the batter angle is measured: one
with the ruled surface above ground level, the other with the ruled surface below
ground level.

Ruled surface

-~

&g Batteredangle

m\.
ﬁBattered bank

e

&9

Ground level

Ground level

—
7

Bafttered bank

Do - Battered angle

Ruled surfaceJ
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Mesh Size

Mesh Size is the number of triangles used within the DTM to generate the
selected surface. This box lets you define how many triangles you want to use.

A higher number will give a more accurate DTM shape, but the DTM will take
longer to generate.

As a rule of thumb, a mesh size of 500 is a good starting value for a selected
ruled surface.

Tip: If in doubt, use a smaller value as it will generate the DTM more quickly
and make it easier for you to determine the appropriate value.

Inserting the Batter

When you click the OK button you are prompted to “Locate the surface to batter”.
Select the ruled surface and the battering will be created. No further user input is
required.

Note: Depending on the complexities of the DTM and the ruled surface it may
take a few minutes to generate the batter — be patient! ©

Note: The batter is created with the currentcolour, style and weight, but it
generated on the same layer as the DTM.

Note: The entire batter process can be reversed with a single Undo command.

Limitation: A current limitation of this command is that the ruled surface should
not extend beyond the edges of the DTM.
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Insert Contours

&

PURPOSE: To generate and insert contours based on the DTM. The contours
are labelled with their heights.

An example of contours is shown below.

20008 4000MM 4550mm

250mm «1250mm

1250mm
1000mm

750mm
500mm

100Qmm 1250mm -
750mm > 250mm

500mm

250mm

Thiscommand slices horizontally through the DTM at multiples of the specified
height and generates the correspondingcontours. The contours are curve
entities and they are drawn at a Z height of zero so they can be used as simple
2D drawing elements.

When the command is selected, the following dialog box is displayed.
CotourOptiors |

Spacing 250

Highlighting Freguency

Test size 4.00 i

Scale test by the plot scale

Cancel

ik
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The text below explains the options in this dialog box.

Spacing

This box lets you define how far apart the contours are spaced. The value
entered is the lowest contour height; subsequent contours are generated at
multiples of that value. For example, if “250” is entered, contours are generated
at 250, 500, 750, 1000 and so on.

The spacing is measured in millimetres.

Highlighting Frequency

By default, contours are drawn in the current colour. This box lets you define
how often the colour is changed to the next colour number, for ease of identifying
the contours. The dialog box above shows that that every fourth contour line
would be drawn in the next colour. For example, if the current colour was 5
(magenta), the first three contours would be drawn inthatcolour, the fourth
contour would drawn in colour 6 (brown), the next three contours would be drawn
in colour 5 again, the eighth contour would be drawn in colour 6 again, and so
on.

Note: Contours are also drawn in the current layer, style and weight, but only the
colour changes as a highlight.

Tip: If you want all contours drawn in the same colour set the Highlighting
Frequencyto a high value; higher than the expected number of contours,
eg, 100.

Text Size

This box lets you define the size at which the text showing the contour heights
will be displayed on the screen. The contour heights are displayed near the ends
of the contours, where possible.

The text size is influenced by the next option, Scale Text by the Plot Scale and
can work in either of the following two ways

1. Ifthe Scale Text by the Plot Scale option is ticked, then the text size
entered is automatically multiplied by the view’s Plot Scale and the text is
displayed on the screen at that scaled size.

For example, if a text size of 4mm is entered and the Plot Scale is 100, the
text will be displayed on screen at 400mm high.

This technique lets you define the text size based on the height you want it
to be when it is printed on paper. If the Plot Scale is changed for some
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reason, the on-screen text height will automatically adjust, but, providing
you print the drawing at the specified Plot Scale, the text will always print
at the height specified.

For example, a text height of 4mm and a Plot Scale of 100 produces on-
screen text at 400mm high. Printing the drawing at a scale of 1:100 will
produce text 4mm high on the paper. Change the Plot Scale to 200 and
the on-screen text will become 800mm high, but printing the drawing at a
scale of 1:200 will still produce text 4mm high on the paper.

2. Ifthe Scale Text by the Plot Scale option is not ticked, then the text size
entered is the on-screen height. It is not, in any way, affected by the
view's Plot Scale.

For the text to be visible on the screen, the size must be calculated
accordingly.

This technique will produce printed text of a different size if the Plot Scale
is changed.

For example, if a text height of 400mm is specified and the Plot Scale is
100, the printed text will be 4mm high, but if the Plot Scale is changed to
200, the printed text would be 2mm high.

Scale Text by the Plot Scale

This tick box controls whether the text size entered is automatically multiplied by
the view's Plot Scale for on-screen display. Refer to the previous section, Text
Size for more details.

Inserting the Contours

When the OK button is clicked the contours are automatically generated; there is
no further user input required.

Note: A DTM must already exist for this command to work.

The first image below shows the contours generated from the DTM below it.
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Adjust Plant Heights
o

PURPOSE: To assign an “adjustment height” to plant. This height will be used to
raise or lower the plant relative to the DTM when the Insert 3D Plants command
(page 114) is run.

Normally the Insert 3D Plants command inserts the plants exactly on the actual
DTM, but this command lets you over-ride that.

This is to facilitate a tree sitting in a pot or raised above the ground on a wall, etc.
The idea is to give you flexibility for each plant/figure.

Visual examples of the effect of this command are shown in the next section,
Insert 3D Plants, on page 114.

Note: A plant, or plants, must be selected before running the command. If this is
not done, the following dialog box will appear.

Set Figure Height

Select the figure entities to define the height of first.

When the command is selected, the following dialog box is displayed.
Set Figure Height ]|
Figure Height 200

Text zsize |4 i

Scale text by the plat scale W

Show Heightsl Cancel |
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The text below explains the options in this dialog box.

Figure Height

This box lets you set the height of the plant, relative to its location on the DTM.
The height is in millimetres.

A positive number will raise the plant above the DTM; a negative number will
lower the plant into the DTM.

Text Size

This box lets you define the size at which the text showing the plant heights will
be displayed on the screen. The heights are displayed next to the plants.

The text size is influenced by the next option, Scale Text by the Plot Scale and
can work in either of the following two ways

1.

If the Scale Text by the Plot Scale option is ticked, then the text size
entered is automatically multiplied by the view’s Plot Scale and the text is
displayed on the screen at that scaled size.

For example, if a text size of 4mm is entered and the Plot Scale is 100, the
text will be displayed on screen at 400mm high.

This technique lets you define the text size based on the height you want it
to be when it is printed on paper. If the Plot Scale is changed for some
reason, the on-screen text height will automatically adjust, but, providing
you print the drawing at the specified Plot Scale, the text will always print
at the height specified.

For example, a text height of 4mm and a Plot Scale of 100 produces on-
screen text at 400mm high. Printing the drawing at a scale of 1:100 will
produce text 4mm high on the paper. Change the Plot Scale to 200 and
the on-screen text will become 800mm high, but printing the drawing at a
scale of 1:200 will still produce text 4mm high on the paper.

Ifthe Scale Text by the Plot Scale option is notticked, then the text size
entered is the on-screen height. It is not, in any way, affected by the
view's Plot Scale.

For the text to be visible on the screen, the size must be calculated
accordingly.

This technique will produce printed text of a different size if the Plot Scale
is changed.

112



LANDWorksCAD V5 Manual

For example, if a text height of 400mm is specified and the Plot Scale is
100, the printed text will be 4mm high, but if the Plot Scale is changed to
200, the printed text would be 2mm high.

Scale Text by the Plot Scale

This tick box controls whether the text size entered is automatically multiplied by
the view's Plot Scale for on-screen display. Refer to the previous section, Text
Size for more details.

When the OK button is clicked, the height value entered is assigned to the
selected plant or plants. There is no visual indication of this; the plants are
simply being preparing for the Insert 3D Plants command. The height values can
be displayed with the Show Heights button (see below).

Show Heights

When this button is clicked the height values are displayed next to each entity, at
the textsize specified, as shown below. The bottom plant hasnot has an
adjustment height assigned to it.

When the height values are displayed, this button changes to “Hide Heights”
letting you hide them if you don’t need to see them any more.

-500

500
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Insert 3D Plants

L

PURPOSE: To place the plants onto the actual DTM based on their position on
the landscape plan.

The 2D plan figures of the plants can be simply moved up onto the DTM or the
elevation/3D figures of the plants, as defined in the plant database, can be
inserted, replacing the 2D figures.

You can switch between the 2D and 3D figures at any stage.

The command finds theinserted plant figures, looks directly above (or below)
them to find their corresponding locations on the DTM and then moves the 2D
figures or inserts the elevation/3D figures as directed.

The figures can be inserted at their current size or updated for a particular age,
based on information in the database, ie, maximum height, maximum width and
maturity.

When the command is selected, the following dialog box is displayed.

Insert 3D Plants H|
— 20430 Dptionz
7 Shaw 200 view % Shaw 30 view
—Age Ophions
" Cument Size = |Update fige
Age |1 T pears j
==

The text below explains the options in this dialog box.

Show 2D View

This option tells LANDWorksCAD to display the 2D plan figures of the plants on
the DTM.

The image below shows plants (red) that have been inserted normally into a
plan. As you can see, they are all below the DTM.
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The plants in the image below have been processed by theInsert 3D Plants
command with the “Show 2D View” option selected. You can see that the plants
have been moved up on to the DTM. This is most obvious in the Front and Right
views (the bottom two). Some plants have had their heights adjusted relative to
the DTM with the Adjust Plant Heights command (see the previous section).
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Show 3D View

This option tells LANDWorksCAD to display the elevation/3D figures of the plants
on the DTM.

The image below shows plants (red) that have been inserted normally into a
plan. As you can see, they are all below the DTM.

I]| & View to - Scale 1:141.39 Plot Scale 1:100.00 N

LR
FRERRERRH
ERERRER)
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SRR

= View Front - Scale 1-114.20 Plot Scale 1:100.00

The plants in the image below have been processed by the Insert 3D Plants
command with the “Show 3D View” option selected. You can see that the plants
have been moved up on to the DTM. This is most obvious in the Front and Right
views (the bottom two). Some plants have had their heights adjusted relative to
the DTM with the Adjust Plant Heights command (see the previous section).
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The type of elevation/3D figure inserted by this option is controlled by the data in
the database. Column C in the database, headed “elev. figure name”, contains
the file names of the elevation/3D figures to be used.

Note: Appendix 1 — The LANDWorksCAD Plant Database contains more
information on this.

The figures can be, as described, either a flat elevation representation of the
plant or a full 3D model.

If the figures are drawn as flat elevations, they will appear as shown in the image
above. Note how the plants are shown as simple, straight lines in the Top view
(top, right window).

However, column K in the database, “number of 2dfigures”, can be used to
make them look more 3D-like. The value in column K is the number of copies of
the elevation figure that will be used. The default is one. Each copy is rotated
evenly, thereby creating a 3D effect from a 2D drawing.
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The table below shows plan and isometric views of a tree with varying number of
2d figures.

No. of 2d figures 1 2 3 4

Plan view

Isometric view

If the figures are drawn as full 3D models, they will display appropriately in all
views. There is definitely no need to have multiple copies, so column K, “number
of 2d figures”, should be set to one.

The image below shows an example of a simple 3D plant, in four differentviews
— Top, Iso, Front and Right.
{i= View Top - Scale 1:348.78 Plot Scale 1:200.00 T[] T || View Iso - Scale | ol x|

~=1oi x|
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Tip: Another way of achieving a more 3D-like effect, without the overhead of
multiple elevation figures or a full 3D model, is to use a single, flat
elevation figure, but have it automatically “oriented to the view”. This
technique means it will always be displayed parallel to the screenno
matter what view you are in or what rotation is applied to the view and thus
it will look like a full plant; it will never turn on its side. This effect can be
achieved by turning on the “Orient to View” setting in the Figure Options
(select Figure > Options from the menu).

Current Size

This option tells LANDWorksCAD to insert the plant figures at their current size,
ie, at the size they were drawn.

Update Age

This option lets you control the size of the plants, based on their age. When this
option is selected the “Age” box below it is activated, as shown below, letting you
select the age at which you want to display the plants. Click on the down arrow
at the end of the box to display a list of ages to select from. You can also type in
the age.

— Y ]|
—20/30 Optionz
€ Show 2D wiew & Show 30 view

—&ge Options
" Cumrent Size &+ Update &ge

Age

3 yearz L|

The resultant size of the plant is determined by the “Update Age” selected
(above) and the plant’'s maximum width, maximum height and maturity from the
plant database.
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The plant’s size is calculated as follows:
Age height = maximum height * age / maturity

Age width = maximum width * age / maturity

Obviously the maximum height, maximum width and maturity data must exist in
the database before the “Update Age” option can work.

Inserting the Plants
When the OK button is clicked, one of two things will happen:

1. Ifplants were selected before the command was run they will be
processed as per the settings.

2. If no plants were selected before the command was run, the following
dialog box will be displayed.

Plant Growth Ed

Modify all plarts?

fes Mo |

Click “Yes” to process all plants as per the settings or click “No” to cancel
thecommand. You canthen select only the plants that are to be
processed and run the command again.
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Insert Sun Light

PURPOSE: To insert a light source in your model that represents the Sun.

When modelling in 3D, this light source can be used to generate shadows in a
Raytraced view.

A sample 3D, raytraced view, with shadows, is shown below.

When the command is selected, the following dialog box is displayed.

Sun Light Options |
Date | 1/09/2005 [+
Time | FO000AM =
City |Spdney NEw =]

Longitude |1 51.13 deq.rmin
Latitude |-33.55 deq.mit
Time Zone Im-':'

Marth Direction | Cancel |

The text below explains the options in this dialog box.
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Date
Thisbox lets you choose the date that will be used to determine the location of
the Sun.

The current date is automatically displayed, butit can be altered to suit your
requirements.

Click on the triangle at the end of the box to display a calendar, as shown below.
The controls for the calendar are indicated.

Click on the required date in the calendar to display it in the box.

Sun Light Options x|

Previous Date 1092006 v month
month
2B September 2006 [Iig
City  |Mon Tuewed Thu Fri Sat Sun Current

26 29 30 3 =

Longild 4y & 5 7 g 3 1gpmmm—y 93

18 19 20 21 22 23 XM
TimeZd 25 26 27 28 29 30 1
2 3 4 &5 B 7 B

Ok | <2 Today: 1/09/2006 el |

Note: The date can also be edited manually. Simply click on the number
representing the day, date or year and type in the required number(s).

Time
This box lets you choose the time of day that will be used to determine the
location of the Sun.

The current time is automatically displayed, butit can be altered to suityour
requirements.

The format of the time is hour:minute:second AM/PM.

To change the numeric part of the time, click on the number and then either:

e type in the new number, or

e click on the up and down spinners , as indicated below
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To change the AM/PM part of the time, click on it then either:
e typeAorP,or
e click on the up and down spinners , as indicated below

Note: AM/PM will change automatically if you change the hour number such that
you pass 12 noon or 12 midnight.

Sun Light Options |
Dat M
e R @
T [ 300:00 &M ——
City ISydne_u M5 j

Longitude |1 51.13 deq.rin
Latitude |-33.55 deg.min
Time Zone I'“:'-':I

Marth Direction | Cancel |

City
This box lets you choose the city that will be used to determine the position of the
Sun.

Click on the triangle at the end of the box to display a list of cities, as shown
below.

Sun Light Options |
Date | 17092008 =]
Time | I00:004M ==
City S ydney M5
Lengitude NT
Latitude T e aLD
Time Zone Wagga Wagga NEWw

F, I Morth Direction Cancel
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You can scroll through the list to find the city you want or you can start typing in
the name of the city. As you type in the name, the list will adjust to display cities
that match what you have typed in, eg, if you type “m”, the list will adjust to
display city names that begin with “m”.

Click on the required city name to display it in the box.

The city names are stored in a file called “cities.dat”, which can be found in your
LANDWorksCAD folder. It is a simple text file and can be edited to suit your
needs.

The format is as follows:
CityName,Longitude, Latitude, Time Difference from GMT,
(GMT = Greenwich Mean Time)

A sample extract is shown below.

San Francisco,-122.27,37.45,-8.0,

Seoul,127.00,37.30,9.0,

Singapore,103.50,1.20,8.0,

Sydney NSW,151.13,-33.55,10.0, _

Tennant Creek NT,134.11,-19.39.95, o o i
Tokyo,139.45,35.40,9.0, the city name.
TownsvilleQLD,146.49,-19.16,10.0,
WaggaWaggaNSW,147.22,-35.07,10.0,
Winnipeg,-97.10,49.53,-6.0,
YularaNT,130.55,-25.10,9.5,

Longitude
This box automatically displays the longitude of the selected city.

Note: If for some reason the longitude is displayed incorrectly it can be edited.
Simply click in the box and enter the correct value. The format of the
longitude is degrees.minutes.

Latitude
This box automatically displays the latitude of the selected city.

Note: If for some reason the latitude is displayed incorrectly it can be edited.
Simply click in the box and enter the correct value. The format of the
latitude is degrees.minutes.
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Time Zone
This box automatically displays the time difference from GMT of the selected city.

Note: If for some reason the time zone is displayed incorrectly it can be edited.
Simply click in the box and enter the correct value.

Inserting the Sun

When the OK button is clicked a light entity is inserted into the model at an
appropriate height and orientation to represent the Sun. No further user inputis
required.

The light entity looks like a small cone, similar to the image shown below.

North Direction Button

The Y axis (as indicated by the workplane icon) is assumed to be pointing north,
however the “North Direction” button lets you specifically define north by
inserting a north figure, as shown below. The orientation of this north figure will
influence the location of the Sun in the drawing.

You are first prompted for the origin (position) of the figure; left click once to
define this.

You are then prompted for the direction of the figure. A rubber band is displayed
between the origin point and your crosshair to help you. Left click again to
indicate the direction of north and the figure is inserted.
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Note: If the north direction is changed after the Sun has been inserted, the Sun
must be re-inserted.

Note: Deleting the north figure is effectively the same as changing it. North will
have been reset to match the Y axis, so the Sun must be re-inserted.

The default north point figure is just that; a LANDWorksCAD figure, and can
therefore be changed if you don't like it.

It is a file called NorthDirection.cad and can be found in your LANDWorksCAD
folder.

To change it, simply open the file, edit it and save it. Alternatively you can draw
your own north point figure from scratch and save it as NorthDirection.cad in your
LANDWorksCAD folder.

If you have already inserted the north point in a drawing, the drawing must be
saved and re-opened to see the new version.

Note: The north point figure must be called NorthDirection.cad and it mustreside
in the LANDWorksCAD folder.
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About
?

PURPOSE: To show theversion number and release date of your
LANDWorksCAD software.

When the command is selected, a dialog box similar to the following is displayed:
Landworks |
LandWorks

Version 5.07 8th September 2006
Copyright 2002 2003, 2004, 2005, 2006 Cad Australia Pty Lid

If a CAD International support person asks you what version of LANDWorksCAD
you are using, this is where you find it. When reporting your version it is
important to also include the date.
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Appendices

The following appendices provide information about the LANDWorksCAD
database that is useful to know, but not essential for day to day use of the
software.
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Appendix 1 — The LANDWorksCAD Plant Database

Structure

The LANDWorksCAD database of plants is a Microsoft Excel spreadsheet file
called LANDWorksPlantDatabase.xls. It must be called this name and it must
be stored in the LANDWorksCAD folder on your computer’s hard disk.

The LANDWorksCAD-V5 plant database contains three worksheets:

e one for existing plants
e one for concept plants
e one for plants

The Existing Plants worksheet lets you set up simple figures to represent the
plants that already exist in your projects.

The ConceptPlants worksheet lets you set up simple figures to use when
creating a concept plan for your clients.

The Plants worksheet is where you store all the plant information related to
existing & proposed plants. The information is used for labelling the existing and
proposed plants as well as creating schedules & legends. Concept plants are
labelled differently.

Note: The word “plant” is used to mean plants and trees.

Format
The format of the worksheets is quite simple:

e Each row in the database contains data that relates to a single plant only,
eg, row 32 contains data for the plant called “Abies grandis”.
Exceptions to this “rule” are explained below.

e Each column contains a particular type of data for each plant, eg, column
N contains the botanical name of each plant.

Note: Excelfunctionality used within the database is noted where appropriate,
but is notnecessarily explained fully in this document. = For more
information consult the Excel Help files or call the CAD International
support line.
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Rows
The format of the rows is identical for each worksheet and is as follows:

Row 1

is used for section headings, eg, “CAD Data’,
“Names”, “General Appearance”, Leaves”, etc.

Rows 2-27 — are used to provide selection data for row 32 and
higher numbered rows, where required.
Row 28 — is used to repeat the section headings from Row 1.

This is done to make it easier to identify whereyou
are in the spreadsheet when freezing rows (Excel
functionality).

Row 29 — is used for specific data headings, eg, “plan figure
name”, “Botanical Name”, “Habit”, etc.
Rows 30, 31 — are not used, but do not delete them.

Rows 32 and higher contain the plant data.

Rows 1-27, 30 and 31 are initially hidden in the supplied database. This is to
prevent users from accidentally, or intentionally, editing the data contained in
these rows before they really know what the data is for. These rows can,
however, be displayed without affecting the functionality of the database in any
way. For instructions on displaying these hidden rows refer to Appendix 3 —
Working with the Selection Data on page 143.

Some row constraints of the database you should be aware of are:
1. You must not add or delete rows within rows 1-31.

2. The plant data must start in row 32 and continue in higher numbered rows,
ie, rows 33, 34, 35 .... 99, 100, 101 ... 1000, 1001, etc.

3. There must be no blank rows in the plant data, ie, row 32 and higher
numbered rows. A blank row is taken to be the end of the plant list.

Some row freedoms of the database you should be aware of are:

1. In the plant data area of the worksheets, ie, row 32 & higher numbered
rows, you can add as many rows as you need, delete rows, move rows,
virtually anything you want.

2. You can add to and/or edit the selection data contained in rows 2-27. This
is explained in Appendix 3 — Working with the Selection Data on page 143.

3. The data headings in row 29 (columnsL-BX only) can be edited to suit
your needs. The words can be changed completely; they can be changed
to be all capitals, etc.
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Columns
The format of the columns is similar, but not identical, for each worksheet.

Existing Plants worksheet
The Existing Plants worksheet contains 5 columns of data, as shown below.

A 5] C 1) E
28 | Actual Data CAD Data Information
29| 22M1/2006 plan figure name image file name [ description | category|
32 Landscape-Symbols\Plants\%existing tree to be removed.cad Landscape-Symbols\Plants\%concept-1.JPG Remove

33 Landscape-Symbols\Plants\%existing tree to be retained.cad Landscape-Symbols\Plants\%concept-1.JPG Retain
M4

ar

The use of the columns is explained below.

Column A - is not used at present. You should not remove it, but can use it for
notes, comments, etc.

CAD Data

Column B - Plan Figure Name — defines the CAD drawing file thatwill be
used to represent the existing plant when displaying the plants
normally in plan view.

Column C - Image File Name — defines the image file (bmp or jpgformat) that
will be used to represent the existing plant when displaying the
plants for presentation purposes in plan view.

Information

Column D - Description — describes the plant. The description for each plant
must be unique.

Column E - Category — defines the category of your existing plant.

If you click in a cell a small box will appear showing the column heading and a
short description of what the data in the cell is used for. An example is shown
below.
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| Landscape-Symbols\Plants\%existing tree to be retained_cadl

CAD Plan Figure Name
Enter the path and name of the
cad file you wish to use to
represent the plan figure of the
existing plant.

&g,

Landscape-
Symbols'Plantsh%exist-1 cad

Some column constraints of this worksheet you should be aware of are:
1. You must not add, delete or move columns within columns A-C.
2. You must not edit in any way the headings in row 29 for columns A-C.
3. The plant data must exist in columns D and E.

Some column freedoms of this worksheet you should be aware of are:

1. In the plant data area of the worksheet, ie, columns D and E, you can add
columns, delete columns and move columns.

2. Data in the columns can be sorted in any order you require, eg, it can be
sorted by plan figure hame, by description, etc. Appendix 4 — Sorting the
Plant Database in Excel on page 153 explains how to do this.

Concept Plants worksheet
The Concept Plants worksheet contains 10 columns of data, as shown below.

[} c ) 3 L & H i i

elev. image file name
~Eymbois:Pants.concept-1-£ PG

B e e |

The use of the columns is explained below.

Column A - is not used at present. You should not remove it, but can use it for
notes, comments, etc.

CAD Data

Column B — Plan Figure Name — defines the CAD drawing file that will be
used to represent the concept plant when displaying the plants
normally in plan view.
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Column D -

Column E -
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Elev. Figure Name — defines the CAD drawing file that will be
used to represent the concept plant when displaying the plants
normally in a non-plan, ie, 3D, views.

Image File Name — defines the image file (bmp or jpgformat) that
will be used to represent the concept plant when displaying the
plants for presentation purposes in plan view.

Elev. Image File Name — defines the image file (bmp or jpg
format) that will be used to represent the concept plant when
displaying the plants for presentation purposes in non-plan, ie, 3D,
views.

Concept Information

Column F -

Column G -

Column H -

Columnl -

ColumnJ -

Description — describes the plant. The description for each plant
must be unique.

Category — defines the category of the conceptplant. Selectfrom
a list.

Shape - defines the general shape of the concept plant. Select
from a list.

Heading — defines a heading that can be semi-automatically
added to the drawing, with the label (see below), to identify your
plant.

Label — defines a label that can be semi-automatically added to
the drawing, with the heading (see above), to identify your plant.

If you click in a cell a small box will appear showing the column heading and a
short description of what the data in the cell is used for. An example is shown

below.

dezcription 8 .TE||| Shrub
Description
Enterthe
description for the
concept plant.

The description
must be unigue.
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Some column constraints of the database you should be aware of are:
1. You must not add, delete or move columns within columns A-E.
2. You must not edit in any way the headings in row 29 for columns A-E.

3. The plant data muststart in column F and continue in higher lettered
columns, ie, columns G, H, etc.

Some column freedoms of the database you should be aware of are:

1. Inthe plant data area of the worksheet, ie, columns E and higher, you can
add columns, delete columns and move columns.

2. Data in the columns can be sorted in any order you require, eg, it can be
sorted by Description, by Category, etc. Appendix 4 — Sorting the Plant
Database in Excel on page 153 explains how to do this.

Plants worksheet
The Plants worksheet contains 76 columns of data, some of which are shown
below.

= L M N 0 P Q R S T ]

25 Names Favourit Type General Appearance
29 ‘abbreviation |abbreviation2 | bolanical name. I Tamily [ commen name [ _common name 2| Cultivars | favourites | type habit

32 Ab gr Abies grandis Grand Fir Canfer

33 Acha Acacia baileyana Fabacese, sub fam. Mim Cootamundra Wattle Golden Mimosa Purpures, Aursa Tres

34 |Ac bu Acacia buxiolia Fabacese, sub fam_Miv B Shnb

35| Ac de Acacia decurrens Fabaceae, sub fam. | Black Wattle Green Watlle Trea
36 Ac sa v Tree
B e op
38 Ac re
3 Ac he Actinotus helianthi Apracese Flannel Flower Sydnay Flannel Flower Federation Stars

40 | Adra Adiantum hispidulum Adiantaceae Maidenhair Fem Syn_ A asthiopicum Fem

The use of the columns is explained below.

Column A - is not used at present. You should not remove it, but can use it
for notes, comments, etc.

CAD Data

Column B - Plan Figure Name — defines the basic 2D CAD drawing file that
will be used to represent the proposed plant when displaying the
plants normally in plan view.

Column C - Elev. Figure Name — defines the basic 2D CAD drawing file that
will be used to represent the proposed plant when displaying the
plants normally in a non-plan, ie, 3D, view.

Column D - 3D FigureName —is no longer used, but the column must not

be deleted.
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Column F

Column G

Column H

Column |

Column J

Column K

Names

Column L

Column M

Column N

Column O
Column P
Column Q

Column R
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Image File Name - defines the image file (bmp or jpg) that will
be used to represent the proposed plant when displaying the
plants for presentation purposes in plan view.

Detail Plan Figure Name — defines the more detailed 2D CAD
drawing file that will be used to represent the proposed plant
when displaying the plants normally in plan view.

Detail Elev. Figure Name — defines the more detailed 2D CAD
drawing file that will be used to represent the proposed plant
when displaying the plants normally in a non-plan, ie, 3D, views.

Elev. Image File Name - defines the image file (bmp or jpg) that
will be used to represent the proposed plant when displaying the
plants for presentation purposes in non-plan, ie, 3D, views.

Line Type — is not used at present. You should not remove it
because it is reserved for future development.

Hatch Pattern — is not used at present. You should notremove
it because it is reserved for future development.

Number of 2d Figures — defines the number of 2D elevation
figures you want to be used to generate a more 3D looking plant.
The section called Show 3D View on page 116 explains how this
data is used.

Abbreviation — defines the abbreviated name of the plant. This
can be any format.

Abbreviation-2 — defines a second abbreviated name of the
plant, if required. This can be any format.

Botanical name — defines the Botanical name of the plant. The
botanical name must be unique.

Family — defines the Family the plant belongs to.
Common Name — defines the Common Name of the plant.

Common Name 2 — defines the secondary Common Name of
the plant, if there is one.

Cultivars — defines the Cultivars of the plant.

135



Favourites

Column S

Type
Column T
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Favourites — defines if the plant is one your favourites. Select
Yes or No from a list.

Type — defines the type of plant. Select from a list.

General Appearance

Column U

Column V

Column W

Column X

Column Y

Column Z
Column AA
Column AB

Leaves
Column AC
Column AD

Column AE

Column AF

Habit — defines the growth habit of the plant. Select from a list.

Texture — defines the overall texture of the plant. Select from a
list.

Maximum Width - defines the maximum width the plant will
grow to if planted in your region in typical conditions. Measured
in millimetres (mm).

Maximum Height — defines the maximum height the plant will
grow to if planted in your region in typical conditions. Measured
in millimetres (mm).

Maturity Age — defines the age, in years, when the plant will
typically be mature.

Density — defines the density of the plant. Select from a list.
Roots — defines the root structure of the plant. Select from a list.

Seasonal — defines the seasonal nature of the plant. Select from
a list.

Leaf Size — defines the leaf size of the plant. Select from a list.

Leaf Character — defines the leaf character of the plant. Select
from a list.

Leaf Colour — defines the leaf colour of the plant. Select from a
list.

Autumn/Fall Leaf Colour — defines the leaf colour of the plant in
Autumn/Fall. Select from a list.
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Flower
Column AG

Column AH

Column Al

Column AJ

Fruit
Column AK

Column AL

Column AM

Column AN

Column AO

Bark
Column AP

Column AQ

Column AR

Region
Column AS

Column AT
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Flowers Season — defines the dominant flowering season of the
plant. Select from a list.

Flower Type — defines the type of flower of the plant. Select

from a list.

Months of Bloom — defines the typical month(s) of bloom of the
plant. Select from a list.

Flower Colour — defines the typical flower colour of the plant.
Select from a list.

Fruit Type — defines the type of fruit of the plant. Select from a
list.

Fruit Size — defines the size of the fruit of the plant. Select from
a list.

Fruit Season — definesthe typical fruiting season of the plant.
Select from a list.

Edible — defines the edibility of the fruit of the plant. Select from
a list.

Fruit Colour — definesthe colour of the fruit of the plant. Select
from a list.

Bark Colour — defines the colour of the bark of the plant. Select
from a list.

Bark Texture — definesthe texture of the bark of the plant.
Select from a list.

Bark Shedding — defines if the bark of the plant sheds or not.
Select from a list.

Global Origin — definesthe globalorigin of the plant. Select

from a list.

Bioclimatic Zone — defines the bioclimaticzone of the plant.
Select from a list.
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Column AU

Column AV

Typical Style
Column AW —

Column AX

Column AY

Uses
Column AZ

Column BA

Column BB
Position
Column BC

Column BD

Column BE

Column BF

Column BG

Column BH

Maintenance

Column BI
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Zone Number — definesthe zone number of the plant. Select

from a list.

Climate Group — definesthe climate group of the plant. Select
from a list.

Style — defines the style of the plant. Select from a list.

Interest — definesthe seasonalinterest of the plant. Select from
a list.

Design Accent — definesthe designaccent of the plant. Select
from a list.

Location Uses — definesthe typical location where the plantis
used. Select from a list.

Special Uses — defines any special uses for the plant. Select

from a list.

Attracts — defines what the plant attracts. Select from a list.

Sun — defines the type of sun/shade the plant likes. Select from
a list.

Tolerances — defines what the plant is tolerant to. Select from a
list.

Soil Type - definesthe preferred soil type for the plant. Select
from a list.

Soil pH - definesthe preferred soil pH for the plant. Select from
a list.

Soil Condition — definesthe preferred soil condition forthe
plant. Select from a list.

Hydrozone — definesthe preferred hydrozone for the plant.
Select from a list.

Maintenance Rating — defines the maintenance rating for the
plant. Select from a list.
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Column BJ

Column BK -

Column BL

Column BM

Column BN

Column BO

Problems
Column BP -

Column BQ

Miscellaneous
Column BR

Column BS

Column BT

Column BU -

Costing

Column BV
Column BW —
Column BX -
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Water — defines the waterrequirements of the plant. Select from
a list.

Pruning — defines how often the plant should be pruned. Select
from a list.

Fertilization — definesthe type of fertilizer required for the plant.
Select from a list.

Integrated Pest Management — defines the type of pest
management required for the plant.

Watering Option 1 — defines how often the plant should be
watered. Select from a list.

Watering Option 2 — defines additional information on how the
plant should be watered.

Susceptibilities — defines any susceptibilities the plant has.
Select from a list.

Adverse Factors — defines any adverse factors relating to the
plant. Select from a list.

Description Text — describes the plant with information not
included in the other columns.

Description 2 — additional or alternative text to describe the
plant.

Nursery ID 1 — definesthe nurseryID or code used to identify
the plant.

Container Size — defines the container size for the plant. Select
from a list.

Price 1 — defines the main price of the plant.
Price 2 — defines an alternative price of the plant.

Price 3 — defines a second alternative price of the plant.
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If you click in a cell a small box will appear showing the column heading and a
short description of what the data in the cell is used for. An example is shown
below.

Botanical Name
Abies grandis

Acac?a bail;ygna Botanical Name F
Acacia buxifalia Enterthe botanical | F
Acacia decurrens | name for the plart. F
Acacia sowdenii It must be unique.
Acacia spetabilis

Brar rohrnim

Some column constraints of the database you should be aware of are:
1. You must not add, delete or move columns within columns A-K.
2. You must not edit in any way the headings in row 29 for columns A-K.

3. The plant data muststartin columnL and continue in higher lettered
columns, ie, columns M, N, O, etc.

Some column freedoms of the database you should be aware of are:

1. In the plant data area of the worksheet, ie, columns L and higher, you can
add columns, delete columns and move columns.

2. Data in the columns can be sorted in any order you require, eg, it can be
sorted by botanical name, by type, etc. Appendix 4 — Sorting the Plant
Database in Excel on page 153 explains how to do this.
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Appendix 2 — Editing the Plant Database in Excel

The plant database can be edited from within LANDWorksCAD or directly in
Microsoft Excel. This appendix explains how to edit the database directly in
Excel.

The explanations apply to the concept, existing and proposed plants.

The explanations assume basic knowledge of Excel.

Editing Existing Plant Data

Editing the database is as simple as opening it in Excel and entering the
appropriate data. Each row pertains to a particular plant. Save the file and the
next time you open LANDWorksCAD or reload the database the new data will be
available.

For the plant data, ie, columns L-BX, simply type in the relevant data or select it
from the available drop down lists.

For the CAD data, ie, columns B—H, you must type in the path and file name of
the figure/image to be used to represent the plants.

If the file is saved in a folder below the LANDWorksCAD folder, the path can start
with the folder directly below the LANDWorksCAD folder, eg, “Landscape-

Symbols\Plants\ ....... .

If the file is not saved in a folder below the LANDWorksCAD folder, the path must
start from the root folder, eg, “C:\Acme Landscaping\Plant Library\ ......".

Note: The file name must include its extension, ie, “.cad”, etc.

Adding a Plant

To add a new plant, simply insert a new row and enter the appropriate data.

Tip: To insert a new row in Excel, select any cell in the row below where you
want the new row and then select Insert > Rows from the menu.

Deleting a Plant
To delete an existing plant, simply delete the row.

Tip: To delete a row in Excel, click on the row number (the entire row will be
selected) and then select Edit > Delete from the menu.
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Re-Arranging/Moving Plants
Any rows from 32 on can be re-arranged or moved to suit your requirements.

Tip:  When re-arranging/moving plants ensure the entire row is selected, not
just the visible cells.

Tip: The basic steps to move a plant are: 1) insert a new row where you want
to move the plant and 2) cut and paste the existing row to the new
position. For more details, please refer to the Excel Help system.

Adding a New Data Item (Column)

To add a new item of data for the plants, simply insert a new column, give it a
heading in row 29 and then enter the appropriate data for each plant.

Tip: Toinsert a new column in Excel, click anywhere in the column to the right
of where you want the new column and then selectInsert - Columns
from the menu.

Deleting an Existing Data Item (Column)
To delete an existing data item, simply delete the column.

Tip: To delete a column in Excel, click on the column letter (the entire column
will be selected) and then select Edit > Delete from the menu.

Re-arranging/Moving Data Items (Columns)

Any data items (columns), except those in the CAD data section (columns A —K)
can be re-arranged or moved to suit your requirements.

Tip: When re-arranging/moving data items ensure theentire column is
selected, not just the visible cells.

Tip: The basic steps to move a column are: 1) insert a new column where you
want to move the data item and 2) cut and paste the existing column to the
new position. For more details, please refer to the Excel Help system.
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Appendix 3 - Working with the Selection Data

When working on your LANDWorksCAD plantdatabase many columns let you
select from a drop-down list of data. An example of this is shown below.

Favourites Type General Appe

favourites type habit

Conifer

Ground cover

Fern

Grass

Herb

Palm

Perennial

Succulent b

Fern

This list is also used when searching for plants in the Insert Plant commands in
LANDWorksCAD, as shown below.

Search Fields:
Field Mame | Operator | Walue |:|
COMmMman hame 2
Culbivars
favourntes —I

habit

texture ildfloner
masimu width Vine

i i Wegetable
rnaximurn height Trew

maturity age Shiub

Search Reset

This appendix explains how to work with these lists of selection data.

Note: Everything in this appendix is specific to Excel. The selection data lists
cannot be edited in LANDWorksCAD.
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Displaying the Hidden Selection Data

The selection data is contained in rows 2-27. Rows 1-27, 30 and 31 are initially
hidden in the supplied database. This is to prevent users from accidentally, or
intentionally, editing the data contained in these rows before they really know
what the data is for. © These rows can, however, be displayed without affecting
the functionality of the database in any way.

To display these hidden rows, do the following:

1. Open the LandworksPlantDatabase.xIs file.
2. Select all rows by clicking on the “Select All” button as shown below:

“ » M33 - e Acacia bailey:
Select All" —
button [ I

28

29 botanical name

32 |Abies grandis
33 |Acacia haileyana
34 | Acacia buxifolia

ar | o . 1

3. The entire worksheet will be highlighted— all cells will have a grey
background.

4. Select Format > Row = Unhide from the menu.
Rows 1-31 will be displayed (you may have to scroll up to see them)
6. To remove the highlighting click in any cell.

o

Note: Saving the database with these rows displayed hasno affect on the
functionality of the database.

Note: The formatting of these rows is white text with a grey background, but this
is for identification only; the colours can be changed to suit you.

As an example of how this selection data works, scroll across tothe Type
column (T), click in the cell in row 32 and then click on the small “down arrow”
that appears to the right of the cell, as shown below. The selection data in the
list that appears is obtained from rows 2-21 in that column. This is the way it
works for all columns; the data is obtained from within rows 2-27 of the column
selected.
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type

/

/

Conifer

Fern

Grass

Ground cover
Herb

Palm
Perennial
Succulent

Fem
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Editing the Existing Selection Data

Changing the Data

You can change the selection data by editing the existing text in the cells and/or
adding new data to the empty cells. To do this, simply click in the cell and type in
what you want.

LANDWorksCAD does notsort the datain any way, so if you want it listed
alphabetically you must do it yourself by re-arranging the cells.

When you have finished editing your selection data, the edited datais
immediately available in the drop-down lists within Excel.

Note: The drop-down lists in LANDWorksCAD will not be updated until you have
saved your database and then either restarted LANDWorksCAD or
reloaded the database.

When you have finished editing your selection data you don’'t have to hide the
rows again. They can be left unhidden and LANDWorksCAD will still read the
data correctly.

Please note the following very important points about the selection data lists:
1. The data can only reside in rows 2-27 and these row humbers are fixed

2. You MUST NOT insert more rows above row 28, the section headings. If
you do, the “Insert Plant” commands in LANDWorksCAD will not work
properly. For now, this means you are limited to a maximum of 26 items in
any list, although this may change in the future.

After editing the selection data, don'’t forget to save your database.

Expanding the Data

If you have not expanded the selection data, ie, you have only edited the existing
text and/or re-arranged the existing cells, then you can save your database and
the new selection data will work fine in LANDWorksCAD. However, if you have
expanded the selection data by entering text in the empty cells, the selection
data range must be updated to include these new cells. The following example
explains how to do this.

This example uses the Type column (T), but the concept applies equally to all
columns that have selection data lists.

In this example, two new entries have been added to the Type list:
“Climber/Creeper” and “Fruit Tree”.
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The standard selection data for column T is shown on the left below and includes
rows 2 —21. The new selection data is shown on the right and includes rows 2 —
23. It includes the two new entries and the data has been rearranged

alphabetically.

Annual
Aquatic

Annual
Aquatic
Bamboo
Biennial
Broadleaf evergreen
Bulb
Cactus
Conifer
Fern
Grass
Ground cover
Herb
Palm
Perennial
Succulent
Shrub
Tree
Vegetable
Vine
Wildflower

Bamboo
Biennial
Broadleaf evergreen
Bulb

Cactus
Climber/Creeper

Conifer

Fruit Tree

Grass
Ground cover
Herb
Palm
Perennial
Succulent
Shrub
Tree

Vegetable
Vine
Wildflower

The following steps were used toupdate the selection data range for this
example:

1. Click in the cell in row 32 for column T.
2. Select Data - Validation from the menu.

3. Selectthe Settings tab on the “Data Validation” dialog box that appears,
as shown below.
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Data Validation x|

| Input Message I Error Alert I

Validation criteria

Allow:

IList j ¥ Ignore blank
Data: ¥ In-cell dropdown
Ibet';:een j

fource:

=8T52:5T521

Cell Selector ]

[™ Apply these changes to all other cells with the same settings

Clear all | 0K I Cancel |

4. The “Allow” box is set to allow a “list” to be selected from.

The “Source” box, as indicated above, shows the cells that contain the list,
ie, the selection data. In this example thisis cells T2 — T21. (Ignore the $
signs; they are inserted automatically by Excel)

6. Click on the “Cell Selector” as shown above.

7. The “Data Validation” dialog box will be reduced in size and the existing
selection data highlighted, as shown below.

Note: The “existing” selection data range may alter from the original depending
on how you edited the data.
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Annual
Aguatic
Bamboo

] Biennial
Broadleaf evergreen
Bulb
Cactus
Climber/Creepe
Conifer
Fern
. FritTree .
Ground cover
Herb
Palm
Perennial
Succulent
Shrub
Tree
Vegetable
Vine
Wildflower

Data Validation

General Appearance
Arching
Broad
Clinging
Columnar

Coarse
Medium
Fine

Existing selection
data highlighted

Pyramidal
Round
Twining
Upright
Vase
Weeping

Reduced Data
Validation dialog box

maximu

Conifer

~|

Highlight the new selection data by dragging your cursor over the cells
until the flashing highlight rectangle includes the new data, as shown
below. The cell numbers in the reduced Data Validation dialog box will

adjust accordingly.
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Type General Appearance
Annual ) Arching Coarse
Aguatic Broad Medium
=ET ) Clinging Fine
Biennial Columnar
Broadleaf evergreen Horizontal
Bulb =
Cactus ! New selection data
Climber/Creeper highlighted
Conifer
Fern : Round
Fruit Tree Twining
Grass Upright
Ground cover e
Herb
Palm
Perennial
Succulent
Shrub
Tree
Vegetable New selection

Vine data range
Wildflower

General Appearance

maximu

Conifer -|

9. Click on the “Cell Selector” again, as shown below. This will enlarge the
“Data Validation” dialog box again.

Data Validation
|=$T$2:$T$221 E
Cell selector

10. Tick the box indicated below to ensure this new selection data applies to
all the other cells in the column. The other cells in column T are
highlighted.

150



LANDWorksCAD V5 Manual

Data Validation x|

Settings | Input Message I Error J!\Jertl

Validation criteria

Allowe:

IList j W Ignore blank
Data: W In-cell dropdown
Ibet'.'.een j

Source:

|=sTs2:67822 =]

[|7 iApply these changes to all other cells with the same settings:

Clear all | oK I Cancel

11. Click OK to finish.

All cells in column T now list the two new entries in their selection data list.

Assigning Selection Data to New Columns

If you add a new column to your database, either of two things will happen to the
selection data for that column:

1. There will be no selection data, ie, rows 2-27 for that column will be
empty, so the selection data list will be empty, or

2. The new column will have inherited the selection data from an adjacent
column so the selection data list will be incorrect because it is pointingto

the wrong column.

In both cases, the correct data will have to be entered into the cells and then the
selection data lists updated to look at it, using the same technique described in
the previous section, Expanding the Data.

Note: The instructions in this section do not cover every function of Data
Validation within Excel. For more details refer to the Excel Help system or
call the CAD International Support line.
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Removing the Selection Data

There may be cases where you do not want the data for a particular column to be
restricted to a pre-defined list; you want to be able to enter any data into the
cells. To do this you must remove the “list” restriction of Excel's Data Validation
function that is used by LANDWorksCAD.

This is done as follows:

1. Select the cells you want to unrestrict. This may be a small selection of
cells or the entire column.

2. Select Data -->Validation from the menu.

3. Depending on the cells selected, you may get a message that some of the
cells do not have Data Validation settings & you'll be asked if you want to
extend the settings to these cells - click “Yes”.

4. Inthe "Settings" tab, the "Allow" field will show the word “List”. Change
this to read “Any value” & then click OK.

5. You can now enter any text you want.

6. Save the database & restart LANDWorksCAD or reload the database for
this new setting to be available.
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Appendix 4 — Sorting the Plant Database in Excel

The plant database supplied with LANDWorksCAD has the plants sorted
alphabetically by their Botanical name, but this can be changed; the plants can
be sorted by any column you want.

However, the database can only be sorted in Excel; it cannot be sorted in
LANDWorksCAD. LANDWorksCAD simply displays the plants in whatever order
they are in Excel.

The secret to sorting the plant database is to NOT select the entire spreadsheet,
as is normally done when sorting a spreadsheet. This is because rows 1-31
should not be included in any sorting; they must remain where they are for the
spreadsheet to work correctly with LANDWorksCAD.

The steps to sorting the database are as follows:

1. Determine by what column you want the data sorted and note the column
letter, eg, to sort by Botanical Name it is column N, to sort by Type it is
column T, etc.

2. Scroll up until you can see row 32. Your screen should look something
like the image below.

K L [ W I M [ 0

2 Names

29 number of 2d figures [abbreviation [abbreviation-2 | botanical name [ family

| 32 1Ab gr Abies grandis

| 33 1Ac ba Acacia baileyana Fabaceae. sub fam. Mimosoide:
| 34 1/Ac bu Acacia buxifolia Fabaceae, sub fam Mimosoide:
135 | 1/Ac de Acacia decurrens Fabaceae, sub fam. Mimosoide:
| 36 | 1 Ac sa Acacia sowdenii

| 37 | 1|Ac sp Acacia spetabilis
| 38 1/Ac re Acer rubrum
| 39| 1 Ac he Actinatus helianthi Apiaceae
| 40 1/Ad ra Adiantum hispidulum Adiantaceae
| 41 1 Ae pa Aesculus pavia
| 42 | 1|Ag pr Agapanthus proecox
| 43 1Al to Allocasuarina torulosa Casuarinaceae
| 44 1 Algl Alnus glutinosa
| 45 | 1/Am gr Amelanchia grandiflora
| 46 1/An co Angophora costata
| 47| 1/An ma Anigozanthos manglesii Haemodoraceae

3. Click on row 32’s identifying number. This will highlight row 32 as shown
below.
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botanical name

1 Acacia baileyana Fabaceae, sub fam. Mimosoide;
1 Ac bu Acacia buxifolia Fabaceae. sub fam. Mimosoide:
1 Ac de Acacia decurrens Fabaceae, sub fam. Mimosoide;
1 Ac sa Acacia sowdenii

1Ac sp Acacia spetabilis

1Acre Acer rubrum

1 Ac he Actinotus helianthi Apiaceae

1Adra Adiantum hispidulum Adiantaceae

1 Ae pa Aesculus pavia

1 Ag pr Agapanthus proecox

1Alto Allocasuarina torulosa Casuarinaceae

1Al gl Alnus glutinosa

1 Am gr Amelanchia grandifiora

1Anco Angophora costata

1 An ma Anigozanthos manglesii Haemodoraceae

Scroll down the screen until you can see the last row of plant data.

Hold down the Shift key and click the last row’s identifying number.

This will highlight all the rows from 32 to the last row of data, as shown
below. Here the last row of data is 266.

number of 2d figures

botanical name

7. Select Data = Sort from the menu.

displayed.
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sort 2 x|
Sort by
TITTTRN -|  éscending
' Descending
Then by
Iﬁ * Ascending
{~ Descending
Then by
Iﬁ * Ascending
{~ Descending

My data range has

{~ Header row {* No header row

Options... | oK I Cancel |

Click in the first “Sort by” field and select the column you want to sort the
data by, eg, column N = Botanical Name, column T = Type, etc.

Make sure the “Ascending” option is selected, as shown above. So the
data is sorted from A to Z.

Make sure the “No header row” option is selected.
Click the OK button.

The plants will now be sorted in alphabetical order by the column you
selected. You may have to scroll back up to see the results.

Saveyour database. The next time you start LANDWorksCAD or reload
the database the plants will be listed in this order.

If you add more plants to the database it's best to insert them so the plants
remain in alphabetical order. If they get mixed up again, simply repeat the
steps listed here to re-sort them.

The dialog box shown above gives you the ability to sort the data by up to
three columns; however this functionality is not covered in this manual.
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